
    Excel

 Introduction to Excel 

 What Is a Spreadsheet? 

     CASE STUDY    |  OK Office Systems 
 You are an assistant manager at OK Office Systems (OKOS) in Toronto. OKOS sells a wide 
range of computer systems, peripherals, and furniture for small- and medium-sized 
organizations in the Greater Toronto Area. To compete against large, global, big-box 
office supply stores, OKOS provides competitive pricing by ordering directly from local 
manufacturers rather than dealing with distributors. 

 Alesha Bennett, the general manager, asked you to calculate the retail price, sale 
price, and profit analysis for selected items on sale this month. Using markup rates pro-
vided by Alesha, you need to calculate the retail price, the amount OKOS charges its 
customers for the products. For the sale, Alesha wants to give customers between a 
10% and 30% discount on select items. You need to use those discount rates to calcu-
late the sale prices. Finally, you will calculate the profit margin to determine the per-
centage of the final sale price over the cost. 

 After you create the initial pricing spreadsheet, you will be able to change values and 
see that the formulas update the results automatically. In addition, you will be able to 
insert data for additional sale items or delete an item based on the manager’s decision. 

 Although your experience with Microsoft Office Excel 2013 may be limited, you are 
excited to apply your knowledge and skills to your newly assigned responsibility. In the 
Hands-On Exercises for this chapter, you will create and format the analytical spread-
sheet to practise the skills you learn.  

     OBJECTIVES     AFTER YOU READ THIS CHAPTER, YOU WILL BE ABLE TO: 

    1.  Explore the Excel window         

    2.  Enter and edit cell data         

    3.  Create formulas         

    4.  Use Auto Fill         

    5.  Display cell formulas              

    6.  Manage worksheets         

    7.  Manage columns and rows         

    8.  Select, move, copy, and paste data         

    9.  Apply alignment and font options         

    10.  Apply number formats          

    11.  Select page setup options          

    12.  Preview and print a worksheet            

From Excel Chapter 1 of Exploring Microsoft® Office 2013, Volume 1, Canadian edition. Mary Anne Poatsy, Keith Mulbery, Lynn Hogan, 
Amy Rutledge, Cynthia Krebs, Eric Cameron, Andy Igonor, Randy Jenne, Marianne Strasser, Kelly Swain, Robert T. Grauer. Copyright © 2014 
by Pearson Canada Inc. All Rights Reserved.
Download student resources at http://www.pearsoncanada.ca/canadiancis.
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Introduction to Spreadsheets 
 Organizing, calculating, and evaluating quantitative data are important skills needed today 
for personal and managerial decision making. You track expenses for your household bud-
get, maintain a savings plan, and determine what amount you can afford for a house or car 
payment. Retail managers create and analyze their organizations’ annual budgets, sales pro-
jections, and inventory records. Charitable organizations track the donations they receive, 
the distribution of those donations, and overhead expenditures.  

 You can use a spreadsheet to maintain data and perform calculations. A  spreadsheet  is 
an electronic file that contains a grid of columns and rows used to organize related data and 
to display results of calculations, enabling interpretation of quantitative data for decision 
making.  

 Performing calculations using a calculator and entering the results into a ledger can lead 
to inaccurate values. If an input value is incorrect or needs to be updated, you have to recal-
culate the results manually, which is time-consuming and can lead to inaccuracies. A spread-
sheet makes data entry changes easy. If the formulas are correctly constructed, the results 
recalculate automatically and accurately, saving time and reducing room for error.  

 In this section, you will learn how to design spreadsheets. In addition, you will explore 
the Excel window and learn the name of each window element. Then, you will enter text, 
values, and dates in a spreadsheet. 

Exploring the Excel Window 
 In Excel, a  worksheet  is a single spreadsheet that typically contains descriptive labels, 
numeric values, formulas, functions, and graphical representations of data. A  workbook  is a 
collection of one or more related worksheets contained within a single file. By default, new 
workbooks contain one worksheet. Storing multiple worksheets within one workbook helps 
organize related data together in one file and enables you to perform calculations among the 
worksheets within the workbook. For example, you can create a budget workbook of 
13 worksheets, one for each month to store your personal income and expenses and a 
final worksheet to calculate totals across the entire year. 

 Excel contains the standard interface of Microsoft Office applications: 
   • Quick Access Toolbar:  Save, Undo, and Redo/Repeat commands  
  • Title bar:  File name (such as Book1) and software name (such as Excel)  
  • Control buttons:  Microsoft Excel Help, Full Screen Mode, Minimize, Restore 

Down, and Close  
  • Ribbon:  Commands (such as Align Left) organized within groups (such as 

Alignment) on various tabs (such as Home)  
  • Scroll bars:  Tools to scroll vertically and horizontally through a worksheet   

Identify Excel Window Elements 
  Figure    1    identifies elements specific to the Excel window, and  Table    1    lists and describes the 
Excel window elements.    
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 TABLE  1   Excel Elements 
 Element  Description 

 Name Box 
 The  Name Box  is an identifier that displays the address of the current cell in the worksheet. Use 
the Name Box to go to a cell, assign a name to one or more cells, or select a function. 

 Cancel          

 When you enter or edit data, click Cancel to cancel the data entry or edit and revert back to the 
previous data in the cell, if any. The Cancel icon changes from grey to red when you position the 
mouse pointer over it. 

 Enter          

 When you enter or edit data, click Enter to accept data typed in the active cell and keep the 
current cell active. The Enter icon changes from grey to blue when you position the mouse pointer 
over it. 

 Insert Function          

 Click to display the Insert Function dialog box to search for and select a function to insert into 
the active cell. The Insert Function icon changes from grey to green when you position the mouse 
pointer over it. 

 Formula Bar 
 The  Formula Bar  shows the contents of the active cell. You can enter or edit cell contents here or 
directly in the active cell. Drag the bottom border of the Formula Bar down to increase the height of 
the Formula Bar to display large amounts of data or a long formula contained in the active cell. 

 Select All   The triangle at the intersection of the row and column headings in the top-left corner of the 
worksheet. Click it to select everything contained in the active worksheet. 

 Column headings  The letters above the columns, such as A, B, C, and so on. 

 Row headings  The numbers to the left of the rows, such as 1, 2, 3, and so on. 

 Active cell  The active cell is the current cell, which is indicated by a dark green border. 

 Sheet tab 
 A  sheet tab  shows the name of a worksheet contained in the workbook. When you create a new 
Excel workbook, the default worksheet is named Sheet1. 

 New sheet   Inserts a new worksheet to the right of the current worksheet. 

 Sheet tab navigation 
buttons 

 If your workbook contains several worksheets, Excel may not show all the sheet tabs at the same 
time. Use the buttons to display the first, previous, next, or last worksheet. 

Formula Bar

Insert Function

Select All

Name Box

Enter

Column heading

Active cell

Row heading

Status bar

Sheet tab navigation buttons

Sheet tab

New sheet

View and Zoom controls

Cancel

FIGURE  1  Excel Window       
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Identify Columns, Rows, and Cells 
 A worksheet contains columns and rows, with each column and row assigned a heading. 
Columns are assigned alphabetical headings from columns A to Z, continuing from AA to AZ, 
and then from BA to BZ until XFD, which is the last of the possible 16,384 columns. Rows have 
numeric headings ranging from 1 to 1,048,576. 

 The intersection of a column and row is a  cell ; a total of more than 17 billion cells are 
available in a worksheet. Each cell has a unique  cell address , identified by first its column 
letter and then its row number. For example, the cell at the intersection of column A and row 
9 is cell A9. Cell references are useful when referencing data in formulas, or in navigation.  

Navigate In and Among Worksheets 
 The  active cell  is the current cell. Excel displays a dark green border around the active cell in 
the worksheet, and the cell address of the active cell appears in the Name Box. The contents 
of the active cell, or the formula used to calculate the results of the active cell, appear in the 
Formula Bar. You can change the active cell by using the mouse to click in a different cell. If 
you work in a large worksheet, use the vertical and horizontal scroll bars to display another 
area of the worksheet and click in the desired cell to make it the active cell. 

 To navigate to a new cell, click it or use the arrow keys on the keyboard. When you press Enter, 
the next cell down in the same column becomes the active cell.  Table    2    lists the keyboard naviga-
tion methods. The Go To command is helpful for navigating to a cell that is not visible onscreen.  

 TABLE  2   Keystrokes and Actions 
 Keystroke  Used to 

         Move up one cell in the same column. 

         Move down one cell in the same column. 

Move left one cell in the same row. 

Move right one cell in the same row. 

 Tab  Move right one cell in the same row. 

 Page Up  Move the active cell up one screen. 

 Page Down  Move the active cell down one screen. 

 Home  Move the active cell to column A of the current row. 

 Ctrl+Home  Make cell A1 the active cell. 

 Ctrl+End 
Make the rightmost, lowermost active corner of the worksheet—the intersection of the last column and 
row that contains data—the active cell. Does not move to cell XFD1048576 unless that cell contains data. 

 F5 or Ctrl+G  Display the Go To dialog box to enter any cell address. 

 TABLE  1   Excel Elements 
 Element  Description 

 Status bar 
 Displays information about a selected command or operation in progress. For example, it displays 
 Select destination and press ENTER or choose Paste  after you use the Copy command. 

 View controls 

 Click a view control to display the worksheet in Normal, Page Layout, or Page Break Preview. 
Normal view displays the worksheet without showing margins, headers, footers, and page breaks. 
Page Layout view shows the margins, header and footer area, and a ruler. Page Break Preview 
indicates where the worksheet will be divided into pages. 

 Zoom control 
 Drag the zoom control to increase the size of the worksheet onscreen to see more or less of the 
worksheet data. 

(continued)
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 To display the contents of another worksheet within the workbook, click the sheet tab 
at the bottom-left corner of the workbook window. The active sheet tab has a white back-
ground colour. After you click a sheet tab, you can then navigate within that worksheet.   

Entering and Editing Cell Data 
 You should plan the structure before you start entering data into a worksheet. Using the 
OKOS case presented at the beginning of the chapter as an example, use the following steps 
to plan the worksheet design, enter and format data, and complete the workbook: 

  Plan the Worksheet Design 

  1. State the purpose of the worksheet.  The purpose of the OKOS worksheet is to store 
data about products on sale and to calculate important details, such as the retail price 
based on markup, the sales price based on a discount rate, and the profit margin.  

  2. Decide what input values are needed.  Input values are the initial values, such as 
variables and assumptions. You may change these values to see what type of effects 
different values have on the end results. For the OKOS worksheet, the input values 
include the costs OKOS pays the manufacturers, the markup rates, and the proposed 
discount rates for the sale. In some worksheets, you can create an  input area , a specific 
region in the worksheet to store and change the variables used in calculations. For 
example, if you applied the same Markup Rate and same Percent Off for all products, it 
would be easier to create an input area at the top of the worksheet to change the values 
in one location rather than in several locations.  

  3. Decide what outputs are needed to achieve the purpose of the worksheet.  Outputs 
are the results you need to calculate. For the OKOS worksheet, the outputs include 
columns to calculate the retail price (i.e., the selling price to your customers), the sale 
price, and the profit margin. In some worksheets, you can create an  output area , the 
region in the worksheet to contain formulas dependent on the values in the input area.   

  Enter and Format the Data 

  4. Enter the labels, values, and formulas in Excel.  Use the design plan (Steps 2–3) as 
you enter labels, input values, and formulas to calculate the output. In the OKOS 
worksheet, descriptive labels (the product names) appear in the first column to indi-
cate that the values on a specific row pertain to a specific product. Descriptive labels 
appear at the top of each column, such as Cost and Retail Price, to describe the values 
in the respective column. Change the input values to test that your formulas produce 
correct results. If necessary, correct any errors in the formulas to produce correct 
results. For the OKOS worksheet, change some of the original costs and markup rates 
to ensure the calculated retail price, selling price, and profit margin percentage results 
update correctly.  

  5. Format the numerical values in the worksheet.  Align decimal points in columns of 
numbers and add number formats and styles. In the OKOS worksheet, use Accounting 
Number Format and the Percent Style to format the numerical data. Adjust the 
number of decimal places as needed.  

  6.    Format the descriptive titles and labels so that they stand out.  Add bold and colour 
to headings so that they stand out and are attractive. Apply other formatting to 
headings and descriptive labels. In the OKOS worksheet, you will centre the main title 
over all the columns, bold and centre column labels over the columns, and apply other 
formatting to the headings.  Figure    2    shows the completed OKOS worksheet.    
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  Complete the Workbook 

  7. Document the workbook as thoroughly as possible.  Include the current date, your 
name as the workbook author, assumptions, and purpose of the workbook. You can 
provide this documentation in a separate worksheet within the workbook. You can 
also add some documentation in the  Properties  section when you click the File tab.  

  8. Save and share the completed workbook.  Preview and prepare printouts for 
distribution in meetings, send an electronic copy of the workbook to those who need 
it, or upload the workbook on a shared network drive or in the cloud.   

Centred title

Formatted column labels

Formatted output range
(calculated results)

Product data organized
into rows

Formatted input range
(Cost, Markup Rate,

and Percent Off)

Enter Text   
Text  is any combination of letters, numbers, symbols, and spaces not used in calculations. 
Excel treats phone numbers, such as 555-1234, and Social Insurance Numbers, such as 
123-456-789, as text entries. You enter text for a worksheet title to describe the contents of 
the worksheet, as row and column labels to describe data, and as cell data. In  Figure    2   , the 
cells in column A, row 1, and row 4 contain text, such as  Product.  Text aligns at the left cell 
margin by default. To enter text in a cell, do the following: 

         1.   Make sure the cell is active where you want to enter text.  
  2.   Type the text.  
  3.   Do one of the following to make another cell the active cell after entering data: 

•   Press Enter on the keyboard.  
  •   Press an arrow key on the keyboard.  
  •   Press Tab on the keyboard.   

  Do one of the following to keep the current cell the active cell after entering data: 

   •   Press Ctrl+Enter.  
  •   Click Enter (the check mark between the Name Box and the Formula Bar).     

 As soon as you begin typing a label into a cell, the  AutoComplete  feature searches for and 
automatically displays any other label in that column that matches the letters you typed. For 
example,  Computer System  is typed in cell A6 in  Figure    2   . When you start to type  Co  in cell 
A7, AutoComplete displays  Computer System  because a text entry previously typed starts 
with  Co . Press Enter to accept the repeated label, or continue typing to enter a different label, 
such as  Colour Laser Printer .     

STEP 1››

  FIGURE  2  Completed OKOS 
Worksheet       

To enable the Canadian 

dictionary in Excel:

1. Click File | Options.

2. Click Language.

3.  From the Add additional 
editing languages menu, 

select English (Canada).
4. Click the Add button.

5.  Click the Set as Default 
button.

6.  You will see a dialog box 

that reads: The new ed-
iting language you just 
chose will take effect 
the next time you start 
Excel. Do you want to 
continue?

7. Click the Yes button.

8. Click the OK button.

9.  You will need to restart 

Excel for the language 

change to take effect.
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Line Break in a Cell 

 If a long text label does not fit well in a cell, you can insert a line break to display the text 
label on multiple lines within the cell. To insert a line break while you are typing a label, 
press Alt+Enter where you want to start the next line of text within the cell. 

   TIP 

  Enter Values 
        Values  are numbers that represent a quantity or a measurable amount. Excel usually dis-
tinguishes between text and value data based on what you enter. The primary difference 
between text and value entries is that value entries can be the basis of calculations, whereas 
text cannot. In  Figure    2   , the data below the  Cost ,  Markup Rates , and  Percent Off  labels are 
values. Values align at the right cell margin by default. After entering values, you can align 
decimal places and apply formatting by adding characters, such as $ or %.  

  Enter Dates 
       You can enter dates and times in a variety of formats in cells, such as 9/1/2016; 9/1/16; 
September 1, 2016; or 1-Sep-16. You can also enter times, such as 1:30 PM or 13:30. You 
should enter a static date to document when you create or modify a workbook or to docu-
ment the specific point in time when the data were accurate, such as on a balance sheet or 
income statement. Later, you will learn how to use formulas to enter dates that update to the 
current date. In  Figure    2   , cell A2 contains a date. Dates are values, so they align at the right 
cell margin. However, the date in  Figure    2    has been centred by the user. 

 Excel displays dates differently from the way it stores dates. For example, the displayed 
date 9/1/2016 represents the first day in September in the year 2016. Excel stores dates as 
serial numbers starting at 1 with January 1, 1900, so 9/1/2016 is stored as 42614 so that you 
can create formulas, such as to calculate how many days exist between two dates.  

  Enter Formulas 
  Formulas  combine cell references, arithmetic operations, values, and/or functions used in a 
calculation. You must start the formula with an equal sign (=). In  Figure    3   , the data below 
the  Retail Price ,  Sale Price ,  Profit Amount , and  Profit Margin  labels contain formulas. When 
a cell containing a formula is the active cell, the formula displays in the Formula Bar, and the 
result of the formula displays in the cell.  

  Edit and Clear Cell Contents 
       You can edit a cell’s contents by doing one of the following: 

   •   Click the cell, click in the Formula Bar, make the changes, and then click Enter (the check 
mark between the Name Box and the Formula Bar) to keep the cell the active cell.  

  •   Double-click the cell, make changes in the cell, and then press Enter.  
  •   Click the cell, press F2, make changes in the cell, and then press Enter.   

 You can clear a cell’s contents by doing one of the following: 
   •   Click the cell and press Delete.  
  •   Click the cell, click Clear in the Editing group on the HOME tab, and then select 

Clear Contents.      

STEP 2››

STEP 3››
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   1.   What are two major advantages of using an electronic spreadsheet instead of a paper-based 
ledger?      

  2.   What visual indicators let you know which cell is the active cell?      

  3.   What steps should you perform before entering data into a worksheet?      

  4.   What are four major things you can enter into a cell? Give an example (different from 
those in the text) for each type.       

   Quick 
Concepts 

✓
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 1 Introduction to Spreadsheets 
As the assistant manager of OKOS, you need to create a worksheet that shows the cost (the amount OKOS pays its suppliers), 
the markup percentage (the amount by which the cost is increased), and the retail selling price. You also need to list the discount 
percentage (such as 25% off) for each product, the sale price, and the profit margin percentage.  

Skills covered: Enter Text • Enter Values • Enter a Date and Clear Cell Contents 

STEP 1 ››   ENTER TEXT 
Now that you have planned the OKOS worksheet, you are ready to enter labels for the title, column labels, and row 
labels. You will type a title in cell A1, product labels in the first column, and row labels in the fourth row. Refer to 
Figure    3    as you complete Step 1.  

  Hands-On Exercises 

a.   Start Excel and open a new blank workbook. Save the new workbook as 
e01h1Markup_LastFirst . 

 When you save files, use your last and first names. For example, as the Excel author, I would 
save my workbook as  e01h1Markup_MulberyKeith .  

  b.   Type  OK Office Systems Pricing Information  in  cell A1  and press  Enter . 

    When you press Enter, the next cell down—cell A2 in this case—becomes the active cell. 
The text does not completely fit in cell A1, and some of the text appears in cells B1, C1, D1, 
and possibly E1. If you make cell B1, C1, D1, or E1 the active cell, the Formula Bar is empty, 
indicating that nothing is stored in those cells.  

  c.   Click  cell A4 , type  Product , and then press  Enter .  

  d.   Continue typing the rest of the text in  cells A5  through  A10  as shown in  Figure    4   . Text in 
column A appears to flow into column B. 

    When you start typing  Co  in cell A6, AutoComplete displays a ScreenTip suggesting a 
previous text entry starting with  Co — Computer System —but keep typing to enter  Color 
Laser Printer  instead. You just entered the product labels to describe the data in each row.  

  e.   Click  cell B4  to make it the active cell. Type  Cost  and press  Tab . 

    Instead of pressing Enter to move down column B, you pressed Tab to make the cell to the 
right the active cell.  

Step e: Label for second column

Step b: Title

Step c: Label for first column

Step d: Name of products

Step f: Labels for other columns

FIGURE  3  Text Entered in 
Cells       
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  f.   Type the following text in the respective cells, pressing  Tab  after typing each of the first four 
column labels and pressing  Enter  after the last column label: 

   •    Markup Rate  in  cell C4   
  •    Retail Price  in  cell D4   
  •    Percent Off  in  cell E4   
  •    Sale Price  in  cell F4   
  •    Profit Margin  in  cell G4    

    The text looks cut off when you enter data in the cell to the right. Do not worry about this 
now. You will adjust column widths and formatting later in this chapter.   

g.   Save the changes you made to the workbook.   

You should develop a habit of saving periodically. That way if your system unexpectedly 
shuts down, you will not lose everything you worked on.  

 TROUBLESHOOTING:     If you notice a typographical error, click in the cell containing the 
error and retype the label. Or press F2 to edit the cell contents, move the insertion point 
using the arrow keys, press Backspace or Delete to delete the incorrect characters, type the 
correct characters, and then press Enter. If you type a label in an incorrect cell, click the cell 
and press Delete. 

   Numeric Keypad 

 To improve your productivity, use the number keypad (if available) on the right side of your 
keyboard. It is much faster to type values and press Enter on the number keypad rather 
than using the numbers on the keyboard. Make sure Num Lock is active before using the 
number keypad to enter values. 

   TIP 

  STEP 2 ››   ENTER VALUES 
 Now that you have entered the descriptive labels, you need to enter the cost, markup rate, and percent off for each 
product. Refer to  Figure    4    as you complete Step 2.  

a.   Click  cell B5 , type  400 , and then press  Enter .  

b.   Type the remaining costs in  cells B6  through  B10  shown in  Figure    4   .     

Steps a–b: Cost values

Steps e–f: Percent Off values

Steps c–d: Markup Rate values

  FIGURE  4  Values Entered in 
Cells       
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c.   Click  cell C5 , type  0.5 , and then press  Enter . 

    You entered the markup rate as a decimal instead of a percentage. You will apply Percent 
Style later, but now you can concentrate on data entry. When you enter decimal values less 
than zero, you can type the period and value without typing the zero first, such as .5. Excel 
will automatically add the zero. You can also enter percentages as 50%, but the approach this 
textbook takes is to enter raw data without typing formatting such as % and to use number 
formatting options through Excel to display formatting symbols.  

d.   Type the remaining markup rates in  cells C6  through  C10  as shown in  Figure    4   .  

e.   Click  cell E5 , type  0.15 , and then press  Enter . 

 You entered the Percent Off or markdown sale value as a decimal.  

f.   Type the remaining Percent Off values in  cells E6  through  E10  as shown in  Figure    4    and 
save the workbook.    

   a.   Click  cell A2 , type  9/1 , and then press  Enter . 

    The date aligns on the right cell margin by default. Excel displays  1-Sep  instead of  9/1 .  

  b.   Click  cell A2 , click  Clear  in the Editing group on the HOME tab, and then select  Clear All . 

    The Clear All command clears both cell contents and formatting in the selected cell(s).  

  c.   Type  9/1/2016  in  cell A2  and press  Enter .   

  STEP 3 ››   ENTER A DATE AND CLEAR CELL CONTENTS 
 As you review the worksheet, you realize you need to provide a date to indicate when the sale starts. Refer to  Figure    5    
as you complete Step 3.  

Step b: Click to display
Clear menu

Step c: Final date

  FIGURE  5  Date Entered in a 
Cell       

d.   Save the workbook. Keep the workbook open if you plan to continue with the next 
Hands-On Exercise. If not, close the workbook and exit Excel.         

 TROUBLESHOOTING:     If you did not use Clear All and typed 9/1/2016 in cell A2, Excel 
would have retained the previous date format and displayed 1-Sep again. 
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Mathematics and Formulas 
 Formulas transform static numbers into meaningful results that can update as values change. 
For example, a payroll manager can build formulas to calculate the gross pay, deductions, 
and net pay for an organization’s employees, or a doctoral student can create formulas to 
perform various statistical calculations to interpret his or her research data. 

 You can use formulas to help you analyze how results will change as the input data 
change. You can change the value of your assumptions or inputs and explore the results 
quickly and accurately. For example, if the interest rate changes from 4% to 5%, how would 
that affect your monthly payment? Analyzing different input values in Excel is easy after you 
build formulas. Simply change an input value and observe the change in the formula results. 

 In this section, you will learn how to use mathematical operations in Excel formulas. 
You will refresh your memory of mathematical order of precedence and how to construct 
formulas using cell addresses so that when the value of an input cell changes, the result of the 
formula changes without you having to modify the formula. 

Creating Formulas 
 Start a formula by typing the equal sign (=), followed by the arithmetic expression. Do not 
include a space before or after the arithmetic operator.  Figure    6    shows a worksheet contain-
ing data and results of formulas. The figure also displays the actual formulas used to generate 
the calculated results. For example, cell E2 contains the formula =B2+B3. Excel uses the value 
stored in cell B2 (10) and adds it to the value stored in cell B3 (2). The result—12—appears 
in cell E2 instead of the actual formula. The Formula Bar displays the formula entered into 
the active cell.   

 TROUBLESHOOTING:   If you type B2+B3 without the equal sign, Excel does not recognize 
that you entered a formula and stores the data as text. 

FIGURE  6  Formula Results       

  Use Cell References in Formulas 
       You should use cell references instead of values in formulas where possible. You may include 
values in an input area—such as dates, salary, or costs—that you will need to reference in 
formulas. Referencing these cells in your formulas, instead of typing the value of the cell to 
which you are referring, keeps your formulas accurate if the values change. 

 When you create a formula, you can type the cell references in uppercase, such as 
=B2+B3, or lowercase, such as =b2+b3. Excel changes cell references to uppercase. 

 In  Figure    6   , cell B2 contains 10, and cell B3 contains 2. Cell E2 contains =B2+B3 but 
shows the result, 12. If you change the value of cell B3 to 5, cell E2 displays the new result, 
which is 15. However, if you had typed actual values in the formula, =10+2, you would have 
to edit the formula each time an input value changes. This would be problematic, as you 
might forget to edit the formula or you might make a typographical error if you edit the for-
mula. Always design worksheets in such a way as to be able to change input values without 
having to modify your formulas if an input value changes later.     

STEP 1››
STEP 2››
STEP 3››
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Constants in Formulas 

 Use cell references instead of actual values in formulas, unless the value is a constant. For 
example, assume that 25% is stored in cell D10. To calculate the reciprocal of 25%, type 
=1-D10. The constant, 1, represents 100%, a value that never changes, although the per-
centage in cell D10 might change. In this situation, 100% – 25% is 75%. 

   TIP 

Apply the Order of Precedence 
       The  order of precedence  (also called order of operations) is a rule that controls the sequence 
in which arithmetic operations are performed, which affects the results of the calculation. 
Excel performs mathematical calculations left to right in this order:  P ercent,  E xponentiation, 
 M ultiplication or  D ivision, and finally  A ddition or  S ubtraction. Some people remember the 
order of precedence with the phrase  P  lease   E  xcuse   M  y   D  ear   A  unt   S  ally . 

  Table    3    lists the complete order of precedence. This chapter focuses on orders 4, 5, 
and 6.     

 TABLE  3   Order of Precedence 
 Order  Description  Symbols 

 1  Reference Operators  colon (:), space, and comma (,) 

 2  Negation  - 

 3  Percent  % 

 4  Exponentiation  ̂  

 5  Multiplication and Division  * and / (respectively) 

 6  Addition and Subtraction  + and – (respectively) 

 7  Concatenation  ampersand symbol (&) to connect two text strings 

 8  Comparison  Equal sign (=), greater than (>), and less than (<) 

  Figure    7    shows formulas, the sequence in which calculations occur, calculations, the 
description, and the results of each order of precedence. The highlighted results are the final 
formula results. This figure illustrates the importance of symbols and use of parentheses.   

   Parentheses in Formulas 

 You can change the order of operations by using parentheses. For example, to add the 
values in cells A1 and A2 and multiply that result by the value in cell A3, enclose parenthe-
ses around the addition operation: =(A1+A2)*A3. Without parentheses, multiplication has 
a higher order of precedence than addition and will be calculated first. 

   TIP 
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  FIGURE  7  Formula 
Results Based on Order of 
Precedence       

Use Semi-Selection to Create a Formula 
 To decrease typing time and ensure accuracy, you can use  semi-selection , a process of select-
ing a cell or range of cells for entering cell references as you create formulas. Semi-selection 
is often called  pointing  because you use the mouse pointer to select cells as you build the 
formula. To use the semi-selection technique to create a formula, do the following: 

         1.   Click the cell where you want to create the formula.  
  2.   Type an equal sign (=) to start a formula.  
  3.   Click the cell or drag to select the cell range that contains the value(s) to use in the 

formula. A moving marquee appears around the cell or range you select, and Excel 
displays the cell or range reference in the formula.  

  4.   Type a mathematical operator.  
  5.   Continue clicking cells, selecting ranges, and typing operators to finish the formula. 

Use the scroll bars if the cell is in a remote location in the worksheet, or click a 
worksheet tab to see a cell in another worksheet.  

  6.   Press Enter to complete the formula.     

Using Auto Fill 
Auto Fill  enables you to copy the contents of a cell or a range of cells by dragging the  fill 
handle  (a small green square appearing in the bottom-right corner of the active cell) over an 
adjacent cell or range of cells. To use Auto Fill, do the following: 

   1.   Click the cell with the content you want to copy to make it the active cell.  
  2.   Point to the fill handle in the bottom-right corner of the cell until the mouse pointer 

changes to the fill pointer (a thin black plus sign).  
  3.   Drag the fill handle to repeat the content in other cells.   

Copy Formulas with Auto Fill 
       After you enter a formula in a cell, you can duplicate the formula without retyping it by using 
the fill handle to copy the formula in the active cell down a column or across a row, depend-
ing on how the data are organized. Excel adapts each copied formula based on the type of cell 
references in the original formula.  

STEP 4››
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Complete Sequences with Auto Fill 
 You can also use Auto Fill to complete a sequence. For example, if you enter January in a cell, 
you can use Auto Fill to enter the rest of the months in adjacent cells. Other sequences you can 
complete are quarters (Qtr 1, etc.), weekdays, and weekday abbreviations, by typing the first 
item and using Auto Fill to complete the other entries. For numeric sequences, however, you 
must specify the first two values in sequence. For example, if you want to fill in 5, 10, 15, and 
so on, you must enter 5 and 10 in two adjacent cells, select the two cells, and then use Auto Fill 
so that Excel knows to increment by 5.  Figure    8    shows the results of filling in months, abbrevi-
ated months, quarters, weekdays, abbreviated weekdays, and increments of 5.  

Incremented values filled in

Click to see Auto Fill Options

 Immediately after you use Auto Fill, Excel displays the Auto Fill Options button in the 
bottom-right corner of the filled data (see  Figure    8   ). Click Auto Fill Options to display five fill 
options: Copy Cells, Fill Series, Fill Formatting Only, Fill Without Formatting, or Flash Fill.     

  FIGURE  8  Auto Fill Examples       

Double-Clicking the Fill Handle 

 You can double-click the fill handle to quickly copy a formula down a column. Excel will 
copy the formula in the active cell for each row of data to calculate in your worksheet.  

   TIP 

Displaying Cell Formulas 
 Excel shows the result of the formula in the cell (see the top half of  Figure    9   ); however, you 
might want to display the formulas instead of the calculated results in the cells (see the bot-
tom half of  Figure    9   ). To display cell formulas, do one of the following: 

         •   Press Ctrl and the grave accent (`) key, sometimes referred to as the tilde (~) key, in 
the top-left corner of the keyboard, below the Esc key.  

  •   Click Show Formulas in the Formula Auditing group on the FORMULAS tab.   

 To hide the formulas and display the formula results again, repeat the preceding process.     

STEP 5››
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   1.   What is the order of precedence? Provide and explain two examples that use four different 
operators, one with parentheses and one without.      

  2.   What is the purpose of Auto Fill? Provide an example of data you can complete using Auto 
Fill.      

  3.   Why would it be useful to display formulas instead of formula results in a worksheet?       

   Quick 
Concepts 

✓

Results of formulas

FIGURE  9  Formulas 
and Formula Results       
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b.   Click  cell D5 , the cell where you will enter the formula to calculate the retail selling price of 
the first item.  

  c.   Type  =B5*(1+C5)  and view the formula and the coloured cells and borders on the screen. 

    As you type or edit a formula, each cell address in the formula displays in a specific 
colour, and while you type or edit the formula, the cells referenced in the formula have a 
temporarily coloured border. For example, in the formula =B5*(1+C5), B5 appears in blue, 
and C5 appears in red. Cell B5 has a temporarily blue border and cell C5 has a temporarily 
red border to help you identify cells as you construct your formulas (see  Figure    10   ).     

 2 Mathematics and Formulas 
In Hands-On Exercise 1, you created the basic worksheet for OKOS by entering text, values, and a date for items on sale. Now you 
need to insert formulas to calculate the missing results—specifically, the retail (before sale) value, sale price, and profit margin. You 
will use cell addresses in your formulas, so when you change a referenced value, the formula results will update automatically. 

Skills covered: Use Cell References in a Formula and Apply the Order of Precedence • Use the Semi-Selection Method to Enter a 
Formula • Use Cell References in a Formula and Apply the Order of Precedence • Copy Formulas with Auto Fill • Change Values 
and Display Cell Formulas 

STEP 1 ››   USE CELL REFERENCES IN A FORMULA AND APPLY THE 
ORDER OF PRECEDENCE 

The first formula you need to create will calculate the retail price. The retail price is the price you originally charge. It is 
based on a percentage of the original cost so that you earn a profit. Refer to  Figure    10    as you complete Step 1.  

  Hands-On Exercises 

a.   Open  e01h1Markup_LastFirst  if you closed it at the end of Hands-On Exercise 1 and save it as 
e01h2Markup_LastFirst , changing  h1  to  h2 .   

 TROUBLESHOOTING:     If you make any major mistakes in this exercise, you can close the 
fi le, open  e01h1Markup_LastFirst  again, and then start this exercise over. 

Step d: Enter command
blue when mouse is over it

Step d: Formula displayed
in Formula Bar

Step c: Red border
and red cell reference

Step c: Blue border
and blue cell reference

  FIGURE  10  Retail Price 
Formula       
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d.   Click  Enter  (the check mark  between the Name Box and the Formula Bar) and view the 
formula in the Formula Bar to check it for accuracy. 

    The result of the formula, 600, appears in cell D5, and the formula displays in the Formula 
Bar. This formula first adds 1 (the decimal equivalent of 100%) to 0.5 (the value stored in 
cell C5). Excel multiplies that sum of 1.5 by 400 (the value stored in cell B5). The theory 
behind this formula is that the retail price is 150% of the original cost.   

   Alternative Formula 

 An alternative formula also calculates the correct retail price: =B5*C5+B5 or =B5+B5*C5. 
In this formula, 400 (cell B5) is multiplied by 0.5 (cell C5); that result (200) represents the 
dollar value of the markup. Excel adds the value 200 to the original cost of 400 to obtain 
600, the retail price. You were instructed to enter =B5*(1+C5) to demonstrate the order of 
precedence. 

   TIP 

 TROUBLESHOOTING:     If the result is not correct, click the cell and look at the formula in 
the Formula Bar. Click in the Formula Bar, edit the formula to match the formula shown in 
Step c, and then click Enter (the check mark between the Name Box and the Formula Bar). 
Make sure you start the formula with an equal sign. 

  e.   Save the workbook with the new formula.    

  STEP 2 ››   USE THE SEMI-SELECTION METHOD TO ENTER A FORMULA 
 Now that you have calculated the retail price, you need to calculate a sale price. This week, the computer is on sale 
for 15% off the retail price. Refer to  Figure    11    as you complete Step 2.  

   a.   Click  cell F5 , the cell where you will enter the formula to calculate the sale price.  

  b.   Type  = , click  cell D5 , type  - , click  cell D5 , type  * , and then click  cell E5 . Notice the colour-
coding in the cell addresses. Press  Ctrl+Enter  to keep the current cell the active cell. 

    You used the semi-selection method to enter a formula. The result is 510. Looking at the 
formula, you might think D5–D5 equals zero; remember that because of the order of 
precedence rules, multiplication is calculated before subtraction. The product of 600 (cell 
D5) and 0.15 (cell E5) equals 90, which is then subtracted from 600 (cell D5), so the sale 
price is 510. If it helps to understand the formula better, add parentheses: =D5-(D5*E5).  

  c.   Save the workbook with the new formula.       

Step b: Formula in
Formula Bar

Step b: Result of
formula in cell

  FIGURE  11  Sale Price Formula       
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a.   Click  cell G5 , the cell where you will enter the formula to calculate the profit margin. 

 The profit margin is the profit (difference in sales price and cost) percentage of the sale 
price.  

b.   Type  =(F5-B5)/F5  and notice the colour-coding in the cell addresses. Press  Ctrl+Enter . 

 The formula must first calculate the profit, which is the difference between the sale price 
(510) and the original cost (400). The difference (110) is then divided by the sale price (510) 
to determine the profit margin of 0.215686, or 21.6%.   

   Spot-Check Your Work 

 You should check the result for logic. Use a calculator to spot-check the accuracy of for-
mulas. If you mark down merchandise by 15% of its regular price, you are charging 85% 
of the regular price. You can spot-check your formula to ensure that 85% of 600 is 510 by 
multiplying 600 by 0.85. 

   TIP 

STEP 3 ››   USE CELL REFERENCES IN A FORMULA AND APPLY THE ORDER 
OF PRECEDENCE 

After calculating the sale price, you want to know the profit margin OKOS will earn. OKOS paid $400 for the computer 
and will sell it for $510. The profit of $110 is then divided by the $400 cost, which gives OKOS a profit margin of 
21.57%. Refer to  Figure    12    as you complete Step 3.  

 TROUBLESHOOTING:     If you type a backslash (\) instead of a forward slash (/), Excel will 
display an error message box. Make sure you type / as the division operator. 

c.   Look at the Formula Bar and save the workbook with the new formula.    

  STEP 4 ››   COPY FORMULAS WITH AUTO FILL 
 After double-checking the accuracy of your calculations for the first product, you are ready to copy the formulas down 
the columns to calculate the retail price, sale price, and profit margin for the other products. Refer to  Figure    13    as you 
complete Step 4.  

Step b: Formula in
Formula Bar

Step b: Result of
formula in cell

FIGURE  12  Profit Margin 
Formula       
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a.   Click  cell D5 , the cell containing the formula to calculate the retail price for the first item.  

b.   Position the mouse pointer on the  cell D5 fill handle . When the pointer changes from a 
white plus sign to a thin black plus sign, double-click the  fill handle . 

    Excel’s Auto Fill feature copies the retail price formula for the remaining products in your 
worksheet. Excel detects when to stop copying the formula when it encounters a blank row, 
such as in row 11.  

  c.   Click  cell D6 , the cell containing the first copied retail price formula, and look at the 
Formula Bar. 

    The formula in cell D5 is =B5*(1+C5). The copied formula in cell D6 is =B6*(1+C6). Excel 
adjusts the cell addresses in the formula as it copies the formula down a column so that the 
results are based on each row’s data rather than using the original formula’s cell addresses for 
other products.   

 TROUBLESHOOTING:     The result in cell D7 may show more decimal places than shown in 
 Figure    13   . This may be due to different screen resolutions. Do not worry about this slight 
difference. 

 TROUBLESHOOTING:     If Excel displays pound symbols, such as ####, instead of results, 
that means the column is not wide enough to show results. You will learn how to adjust 
column widths in the third section. 

d.   Select the  range F5:G5 . Double-click the  fill handle  in the bottom-right corner of  cell G5 . 

    Auto Fill copies the selected formulas down their respective columns. Auto Fill Options 
are available down and to the right of the cell G10 fill handle, indicating you could select 
different fill options if you want.   

  e.   Click  cell F6 , the cell containing the first copied sale price formula, and view the 
Formula Bar. 

    The original formula was =D5-D5*E5. The copied formula in cell F6 is adjusted to 
=D6-D6*E6 so that it calculates the sales price based on the data in row 6.  

  f.   Click  cell G6 , the cell containing the first copied profit margin formula, and look at the 
Formula Bar. Save the workbook. 

    The original formula was =(F5-B5)/F5, and the copied formula in cell G6 is =(F6-B6)/F6.    

Step f: Cell references adjust
in copied Profit Margin formula

Step a: Cell contains
original Retail Price formula

Step c: Results after copying
Retail Price formula

Step e–f: Results after
copying Sale Price and
Profit Margin formulas

Step d: Auto Fill Options button

FIGURE  13  Formulas Copied 
with Auto Fill       
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a.   Click  cell B5 , type  475.5 , and then press  Enter . 

 The results of the retail price, sale price, and profit margin formulas change based on the 
new cost.  

b.   Click  cell C6 , type  0.755 , and then press  Enter . 

    The results of the retail price, sale price, and profit margin formulas change based on the 
new markup rate.  

c.   Click  cell E7 , type  0.05 , and then press  Ctrl+Enter . 

    The results of the sale price and profit margin formulas change based on the new markdown 
rate. Note that the retail price did not change, since that formula is not based on the 
markdown rate.  

d.   Press  Ctrl+`  (the grave accent mark). 

    The workbook now displays the formulas rather than the formula results (see  Figure    15   ). 
This is helpful when you want to review several formulas at one time.   

STEP 5 ››   CHANGE VALUES AND DISPLAY CELL FORMULAS 
You want to see how the prices and profit margins are affected when you change some of the original cost values. 
For example, the supplier might notify you that the cost to you will increase. In addition, you want to see the formulas 
displayed in the cells temporarily. Refer to  Figures    14    and     15    as you complete Step 5.  

  e.   Press  Ctrl+ ̀  (the grave accent mark). 

    The workbook now displays the formula results in the cells again. 

   f. Save the workbook. Keep the workbook open if you plan to continue with the next 
Hands-On Exercise. If not, close the workbook and exit Excel.         

Step a: Updated results in
cells D5, F5, and G5

Step c: Updated results
in cells F7 and G7

Step a: New value in cell B5

Step b: New value in cell C6

Step c: New value in cell E7

FIGURE  14  Results of 
Changed Values       

Step d: Values appear
left aligned

Step d: Formulas displayed
instead of results

Step d: Date displays as
serial number

FIGURE  15  Formulas in Cells       
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Workbook and Worksheet 
Management 
 When you start a new blank workbook in Excel, the workbook contains one worksheet 
named Sheet1. However, you can add additional worksheets. The text, values, dates, and 
formulas you enter into the individual sheets are saved under one workbook file name. 
Having multiple worksheets in one workbook is helpful to keep related items together. For 
example, you might want one worksheet for each month to track your monthly income and 
expenses for one year. When tax time comes around, you have all your data stored in one 
workbook file. 

 Although you should plan the worksheet and workbook before you start entering data, 
you might need to add, delete, or rename worksheets. Furthermore, within a worksheet you 
may want to insert a new row to accommodate new data, delete a column that you no longer 
need, or adjust the size of columns and rows. 

 In this section, you will learn how to manage workbooks by renaming, inserting, and 
deleting worksheets. You will also learn how to make changes to worksheet columns and 
rows, such as inserting, deleting, and adjusting sizes. 

Managing Worksheets 
 Creating a multiple-worksheet workbook takes some planning and maintenance. Worksheet 
tab names should reflect the contents of the respective worksheets. In addition, you can 
insert, copy, move, and delete worksheets within the workbook. You can even apply back-
ground colour to the worksheet tabs so that they stand out onscreen.  Figure    16    shows a 
workbook in which the sheet tabs have been renamed, colours have been applied to work-
sheet tabs, and a worksheet tab has been right-clicked so that the shortcut menu appears.  

Shortcut menu

Click Format for
formatting options

Renamed sheets and
coloured tabs

Click to insert a
new worksheet

FIGURE  16  Worksheet Tabs       
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Rename a Worksheet 
       The default worksheet name Sheet1 does not describe the contents of the worksheet. You 
should rename worksheet tabs to reflect the sheet contents. For example, if your budget 
workbook contains monthly worksheets, name the worksheets September, October, etc. 
Although you can have spaces in worksheet names, keep worksheet names relatively short. 
The longer the worksheet names, the fewer sheet tabs you will see at the  bottom of the work-
book window without scrolling. 

 To rename a worksheet, do one of the following: 
   •   Double-click a sheet tab, type the new name, and then press Enter.  
  •   Click the sheet tab for the sheet you want to rename, click Format in the Cells group 

on the HOME tab (refer to  Figure    16   ), select Rename Sheet (see  Figure    17   ), type the 
new sheet name, and then press Enter.  

  •   Right-click the sheet tab, select Rename from the shortcut menu (see  Figure    16   ), 
type the new sheet name, and then press Enter.     

STEP 1››

Change Worksheet Tab Colour 
       The active worksheet tab is white with a green bottom border. When you use multiple work-
sheets, you might want to apply a different colour to each worksheet tab to make the tab 
stand out or to emphasize the difference between sheets. For example, you might apply red 
to the September tab, green to the October tab, dark blue to the November tab, and purple 
to the December tab. 

 To change the colour of a worksheet tab, do one of the following: 
   •   Click the sheet tab for the sheet you want to rename, click Format in the Cells group 

on the HOME tab (refer to  Figure    16   ), point to Tab Color (refer to  Figure    17   ), and 
then click a colour on the Tab Color palette.  

  •   Right-click the sheet tab, point to Tab Color on the shortcut menu (refer to 
 Figure    16   ), and then click a colour on the Tab Color palette.    

STEP 1››

FIGURE  17  Format Menu       
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Insert and Delete a Worksheet 
       Sometimes you need more than one worksheet in the workbook. For example, you might 
create a workbook that contains 12 worksheets—a worksheet for each month of the year. To 
insert a new worksheet, do one of the following: 

   •   Click  New sheet  to the right of the last worksheet tab.  
  •   Click the Insert arrow—either to the right or below Insert—in the Cells group on 

the HOME tab and select Insert Sheet.  
  •   Right-click any sheet tab, select Insert from the shortcut menu (refer to  Figure    16   ), 

click Worksheet in the Insert dialog box, and then click OK.  
  •   Press Shift+F11.      

STEP 2››

   Ribbon Commands with Arrows 

 Some commands, such as Insert in the Cells group, contain two parts: the main command 
and an arrow. The arrow may be below or to the right of the command, depending on the 
command, window size, or screen resolution. Instructions in the Exploring Series use the 
command name to instruct you to click the main command to perform the default action, 
such as Click Insert in the Cells group or Click Delete in the Cells group. Instructions 
include the word arrow when you need to select an additional option, such as Click the 
Insert arrow in the Cells group or Click the Delete arrow in the Cells group. 

   TIP 

 If you no longer need the data in a worksheet, delete the worksheet. Doing so will elimi-
nate extra data in a file and reduce file size. To delete a worksheet in a workbook, do one of 
the following: 

   •   Click the Delete arrow—either to the right or below Delete—in the Cells group on the 
HOME tab and select Delete Sheet.  

  •   Right-click any sheet tab and select Delete from the shortcut menu (refer to 
 Figure    16   ).   

 If the sheet you are trying to delete contains data, Excel will display a warning:  You can’t 
undo deleting sheets, and you might be removing some data. If you don’t need it, click Delete . 
If you try to delete a blank worksheet, Excel will not display a warning; it will immediately 
delete the sheet.  

  Move or Copy a Worksheet 
       After inserting and deleting worksheets, you can arrange the worksheet tabs in a different 
sequence, especially if the newly inserted worksheets do not fall within a logical sequence. To 
move a worksheet, do one of the following: 

   •   Drag a worksheet tab to the desired location. As you drag a sheet tab, the pointer 
resembles a piece of paper. A down-pointing triangle appears between sheet tabs to 
indicate where the sheet will be placed when you release the mouse button.  

  •   Click Format in the Cells group on the HOME tab (refer to  Figure    16   ) and select 
Move or Copy Sheet, or right-click the sheet tab you want to move and select Move 
or Copy to display the Move or Copy dialog box (see  Figure    18   ). You can move the 
worksheet within the current workbook, or you can move the worksheet to a differ-
ent workbook. In the  Before sheet  list, select the worksheet you want to come after 
the moved worksheet and click OK. For example, you have just created a new work-
sheet named August and you want it to come before the September worksheet. You 
would select September in the  Before sheet  list.    
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 After creating a worksheet, you may want to copy it to use as a template or starting point 
for similar data. For example, if you create a worksheet for your September budget, you can 
copy the worksheet and then easily edit the data on the copied worksheet to enter data for 
your October budget. Copying the entire worksheet would save you a lot of valuable time in 
entering and formatting the new worksheet. The process for copying a worksheet is simi-
lar to moving a sheet. To copy a worksheet, press and hold Ctrl as you drag the worksheet 
tab. Alternatively, display the Move or Copy dialog box, select the  To book  and  Before sheet  
options (refer to  Figure    18   ), click the  Create a copy  check box, and then click OK.   

Managing Columns and Rows 
 As you enter and edit worksheet data, you can adjust the row and column structure. You can 
add rows and columns to add new data, or you can delete data you no longer need. Adjusting 
the height and width of rows and columns, respectively, can present the data better. 

Insert Cells, Columns, and Rows 
       After you construct a worksheet, you might need to insert cells, columns, or rows to accom-
modate new data. For example, you might need to insert a new column to perform calcu-
lations or a new row to list a new product. When you insert cells, rows, and columns, cell 
addresses in formulas adjust automatically. 

 To insert a new column or row, do one of the following: 
   •   Click in the column or row for which you want to insert a new column to the left or a 

new row above, respectively. Click the Insert arrow in the Cells group on the HOME 
tab and select Insert Sheet Columns or Insert Sheet Rows.  

  •   Right-click the column (letter) or row (number) heading for which you want to 
insert a new column to the left or a new row above, respectively, and select Insert 
from the shortcut menu.   

 Excel inserts new columns to the left of the current column and new rows above the 
active row. If the current column is column C and you insert a new column, the new column 
becomes column C, and the original column C data are now in column D. Likewise, if the 
current row is 5 and you insert a new row, the new row is row 5, and the original row 5 data 
are now in row 6. 

 Inserting a cell is helpful when you realize that you left out an entry in one column 
after you have entered columns of data. Instead of inserting a new row for all columns, you 
just want to move the existing content down in one column to enter the missing value. You 
can insert a single cell in a particular row or column. To insert a cell, click in the cell where 
you want the new cell, click the Insert arrow in the Cells group on the Home tab, and then 
select Insert Cells. Select an option from the Insert dialog box (see  Figure    19   ) to position 
the new cell and click OK. Alternatively, click Insert in the Cells group. The default action of 

STEP 3››

FIGURE  18  Move or Copy 
Dialog Box       

Select workbook to contain
moved or copied sheet

Select sheet to move
sheet in front of

Click to copy instead of
move the worksheet
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  Adjust Column Width 
       After you enter data in a column, you often need to adjust the  column width —the number 
of characters that can fit horizontally using the default font or the number of horizontal 
 pixels—to show the contents of cells. For example, in the worksheet you created in Hands-On 
Exercises 1 and 2, the labels in column A displayed into column B when those adjacent cells 
were empty. However, after you typed values in column B, the labels in column A appeared 
cut off. You will need to widen column A to show the full name of all of your products.    

STEP 5››

 clicking Insert is to insert a cell at the current location, which moves existing data down in 
that  column only.   

  FIGURE  19  Insert Dialog Box       

  Delete Cells, Columns, and Rows 
       If you no longer need a cell, column, or row, you can delete it. In these situations, you are 
deleting the entire cell, column, or row, not just the contents of the cell to leave empty cells. 
As with inserting new cells, any affected formulas adjust the cell references automatically. To 
delete a column or row, do one of the following: 

   •   Click the column or row heading for the column or row you want to delete. Click 
Delete in the Cells group on the HOME tab.  

  •   Click in any cell within the column or row you want to delete. Click the Delete 
arrow in the Cells group on the HOME tab and select Delete Sheet Columns or 
Delete Sheet Rows, respectively.  

  •   Right-click the column letter or row number for the column or row you want to 
delete and select Delete from the shortcut menu.   

 To delete a cell or cells, select the cell(s), click the Delete arrow in the Cells group, and 
then select Delete Cells to display the Delete dialog box (see  Figure    20   ). Click the appropriate 
option to shift cells left or up and click OK. Alternatively, click Delete in the Cells group. The 
default action of clicking Delete is to delete the active cell, which moves existing data up in 
that column only.   

STEP 4››

  FIGURE  20  Delete Dialog Box       

   Pound Signs Displayed 

 Numbers appear as a series of pound signs (######) when the cell is too narrow to display 
the complete value, and text appears to be truncated. 

   TIP 
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 To widen a column to accommodate the longest label or value in a column, do one of 
the following: 

•   Position the pointer on the vertical border between the current column heading and 
the next column heading. When the pointer displays as a two-headed arrow, double-
click the border. For example, if column B is too narrow to display the content in that 
column, double-click the border between the column B and C headings.  

  •   Click Format in the Cells group on the HOME tab (refer to  Figure    16   ) and select 
AutoFit Column Width (refer to  Figure    17   ). 

 To widen a column to an exact width, do one of the following:  
  •   Drag the vertical border to the left to decrease the column width or to the right to 

increase the column width. As you drag the vertical border, Excel displays a ScreenTip 
specifying the width (see  Figure    21   ) from 0 to 255 characters and in pixels.  

  •   Click Format in the Cells group on the HOME tab (refer to  Figure    16   ), select 
Column Width (refer to  Figure    17   ), type a value in the Column width box in the 
Column Width dialog box, and then click OK.     

  FIGURE  21  Changing Column 
Width       

ScreenTip displaying
column width

Current column width

Column width when you
release the mouse button

Mouse pointer as you
drag the border between

column headings

Adjust Row Height 
       When you increase the font size of cell contents, Excel automatically increases the  row height —
the vertical measurement of the row. However, if you insert a line break or wrap text to create 
multiple lines of text in a cell, Excel might not increase the row height. You can adjust the 
row height in a way similar to how you change column width by double-clicking the border 
between row numbers or by selecting Row Height or AutoFit Row Height from the Format 
menu (refer to  Figure    17   ). In Excel, row height is a value between 0 and 409 based on point 
size (abbreviated as pt) and pixels. Whether you are measuring font sizes or row heights, one 
point size is equal to 1/183 of a centimetre (1/72 of an inch). Your row height should be taller 
than your font size. For example, with an 11-pt font size, the default row height is 15.     

   Multiple Column Widths and Row Heights 

 You can set the size for more than one column or row at a time to make the selected col-
umns or rows the same size. Drag across the column or row headings for the area you want 
to format, and then set the size using any method. 

   TIP 
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   Unhiding Column A, Row 1, and All Hidden Rows/
Columns 

 Unhiding column A or row 1 is different because you cannot select the row or column on 
either side. To unhide column A or row 1, type A1 in the Name Box and press Enter. Click 
Format in the Cells group on the Home tab, point to Hide & Unhide, and then select 
Unhide Columns or Unhide Rows to display column A or row 1, respectively. If you want to 
unhide all columns and rows, click Select All and use the Hide & Unhide submenu. 

   TIP 

   1.   What is the benefit of renaming a worksheet?      

  2.   What are two ways to insert a new row in a worksheet?      

  3.   How can you delete cell B5 without deleting the entire row or column?      

  4.   When should you adjust column widths instead of using the default width?       

   Quick 
Concepts 

✓

  Hide and Unhide Columns and Rows 
       If your worksheet contains confidential information, you might need to hide some columns 
and/or rows before you print a copy for public distribution. However, the column or row is 
not deleted. If you hide column B, you will see columns A and C side by side. If you hide row 
3, you will see rows 2 and 4 together.  Figure    22    shows that column B and row 3 are hidden. 
Excel displays a double line between column headings (such as between A and C), indicating 
one or more columns are hidden, and a double line between row headings (such as between 
2 and 4), indicating one or more rows are hidden.  

STEP 6››

 To hide a column or row, do one of the following: 
   •   Click in the column or row you want to hide, click Format in the Cells group on the 

HOME tab (refer to  Figure    16   ), point to Hide & Unhide (refer to  Figure    17   ), and then 
select Hide Columns or Hide Rows, depending on what you want to hide.  

  •   Right-click the column or row heading(s) you want to hide and select Hide.   

 You can hide multiple columns and rows at the same time. To select adjacent columns 
(such as columns B through E) or adjacent rows (such as rows 2 through 4), drag across the 
adjacent column or row headings. To hide nonadjacent columns or rows, press and hold Ctrl 
while you click the desired column or row headings. After selecting multiple columns or 
rows, use any acceptable method to hide the selected columns or rows. 

 To unhide a column or row, select the columns or rows on both sides of the hidden col-
umn or row. For example, if column B is hidden, drag across column letters A and C. Then 
do one of the following: 

   •   Click Format in the Cells group on the HOME tab (refer to  Figure    16   ), point to Hide 
& Unhide (refer to  Figure    17   ), and then select Unhide Columns or Unhide Rows, 
depending on what you want to display again.  

  •   Right-click the column(s) or row(s) you want to hide and select Unhide.         

Double horizontal line
indicates hidden row

Double vertical line
indicates hidden column

  FIGURE  22  Hidden Column 
and Row       
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 3 Workbook and Worksheet Management 
After reviewing the OKOS worksheet, you decide to rename the worksheet, change the worksheet tab colour, insert a worksheet, 
and delete an empty worksheet. In addition, you need to insert a column to calculate the amount of markup and delete a row 
containing data you no longer need. You also need to adjust column widths to display the labels in the columns. 

Skills covered: Rename a Worksheet and Select a Tab Colour • Insert, Move, and Delete a Worksheet • Insert a Column and Rows 
• Delete a Row • Adjust Column Width and Row Height • Hide and Unhide Columns 

STEP 1 ››   RENAME A WORKSHEET AND SELECT A TAB COLOUR 
You want to rename Sheet1 to describe the worksheet contents and add a colour to the sheet tab. Refer to  Figure    23    
as you complete Step 1.  

   a.   Open  e01h2Markup_LastFirst  if you closed it at the end of Hands-On Exercise 2 and save it as 
 e01h3Markup_LastFirst , changing  h2  to  h3 .  

  b.   Double-click the  Sheet1 sheet tab , type  September , and then press  Enter . 

    You renamed Sheet1 September.  

  c.   Right-click the  September sheet tab , point to  Tab Color , and then click  Red  in the  Standard 
Colors  section. 

    The worksheet tab colour is red.  

  d.   Save the workbook.    

STEP 2 ››   INSERT, MOVE, AND DELETE A WORKSHEET 
Your supervisor asks you to add another worksheet to the workbook. She wants you to place it before the September 
worksheet so that she can add August data. After you do this, she calls you on the phone and tells you that she won’t be 
adding the August data after all. Therefore, you will delete that worksheet. Refer to  Figure    24    as you complete Step 2.  

   a.   Click  New sheet , the plus icon to the right of the September sheet tab. 

    Excel adds a new worksheet named either Sheet1 or Sheet2 to the right of the previously 
active sheet.  

  b.   Drag the  Sheet tab  to the left of the September sheet tab.  

  c.   Click the  Sheet tab , click the  Delete arrow  in the Cells group on the HOME tab, and then 
select  Delete Sheet . 

    You deleted the blank worksheet from the workbook.    

FIGURE  23  Renamed 
Worksheet with Tab Colour       

Step a: Click to insert new sheet

Step b: New sheet moved to the left

FIGURE  24  New Sheet 
Inserted       

HOE3 TrainingWatch the Video 
for this Hands-
On Exercise!

  Hands-On Exercises 

Hands-On Exercise 3 401

M07_GRAU2679_01_SE_E01_PCL.indd   401 7/25/13   2:40 PM



Hands-On Exercise 3402

a.   Click  cell G5  (or any cell in column G), the column containing the Profit Margin. 

 You want to insert a column between the Sale Price and Profit Margin columns so that you 
can calculate the profit amount in dollars.  

b.   Click the  Insert arrow  in the Cells group and select  Insert Sheet Columns . 

    You inserted a new, blank column G. The data in the original column G are now in 
column H.  

  c.   Click  cell G4 , type  Profit Amount , and then press  Enter .  

  d.   Make sure the active cell is  cell G5 . Type  =F5-B5  and click  Enter  (the check mark between 
the Name Box and the Formula Bar). Double-click the  cell G5 fill handle  to copy the 
formula down the column. 

    You calculated the profit amount by subtracting the original cost from the sale price. 
Although steps e and f below illustrate one way to insert a row, you can use other methods 
presented in this chapter.  

  e.   Right-click the  row 5 heading , the row containing the Computer System data. 

    Excel displays a shortcut menu consisting of commands you can perform.  

  d.   Save the workbook.    

 TROUBLESHOOTING:     Delete in the Cells group, like some other commands in Excel, 
contains two parts: the main command icon and an arrow. Click the main command 
icon when instructed to click Delete to perform the default action. Click the arrow when 
instructed to click the Delete arrow for additional command options. 

 TROUBLESHOOTING:     Notice that Undo is unavailable on the Quick Access Toolbar. You 
cannot undo deleting a worksheet. It is deleted! 

STEP 3 ››   INSERT A COLUMN AND ROWS 
You decide that you need a column to display the amount of profit. Because profit is a dollar amount, you want to 
keep the profit column close to another column of dollar amounts. Therefore, you will insert the profit column before 
the profit margin (percentage) column. You also want to insert new rows for product information and category names. 
Refer to  Figure    25    as you complete Step 3.  

Step b: Profit Margin data
in column H now

Step d: Profit Amount
formula entered

Step b: Insert menu

Step c: Label for the column

Step f–g: New row

Step h–i: New row

FIGURE  25  Column and Rows 
Inserted       
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  f.   Select  Insert  from the shortcut menu. 

    You inserted a new blank row 5, which is selected. The original rows of data move down a 
row each.  

  g.   Click  cell A5 . Type  Electronics  and press  Ctrl+Enter . Click  Bold  in the Font group on the 
HOME tab. 

    You typed and bolded the category name  Electronics  above the list of electronic products.  

  h.   Right-click the  row 8 heading , the row containing the Filing Cabinet data, and select  Insert  
from the shortcut menu.  

  i.   Click  cell A8 . Type  Furniture  and press  Ctrl+Enter . Click  Bold  in the Font group on the 
HOME tab. 

    You typed and bolded the category name  Furniture  above the list of furniture products.  

  j.   Save the workbook.    

   a.   Click  cell A9  (or any cell on row 9), the row that contains the Filing Cabinet data.  

  b.   Click the  Delete arrow  in the Cells group.  

  c.   Select  Delete Sheet Rows  and save the workbook.   

  The Filing Cabinet row is deleted and the remaining rows move up one row.   

 TROUBLESHOOTING:     If you accidentally delete the wrong row or accidentally select 
Delete Sheet Columns instead of Delete Sheet Rows, click Undo on the Quick Access 
Toolbar to restore the deleted row or column. 

STEP 4 ››   DELETE A ROW 
You just realized that you do not have enough filing cabinets in stock to offer on sale, so you need to delete the Filing 
Cabinet row. Refer to  Figure    26    as you complete Step 4.  

Step c: Filing Cabinet
row deleted

Step b: Click Delete arrow

FIGURE  26  Row Deleted       
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a.   Position the pointer between the column A and B headings. When the pointer looks like a 
double-headed arrow, double-click the border. 
 When you double-click the border between two columns, Excel adjusts the width of the 
column on the left side of the border to fit the contents of that column. Excel increased the 
width of column A based on the cell containing the longest content (the title in cell A1, 
which will eventually span over all columns). Therefore, you want to decrease the column to 
avoid so much empty space in column A.  

b.   Position the pointer between the column A and B headings again. Drag the border to the left 
until the ScreenTip displays  Width: 23.00 (166 pixels) . Release the mouse button. 

    You decreased the column width to 23 for column A. The longest product name is visible. 
You will not adjust the other column widths until after you apply formats to the column 
headings in Hands-On Exercise 5.  

  c.   Click  cell A1 . Click  Format  in the Cells group and select  Row Height  to display the Row 
Height dialog box.  

  d.   Type  30  in the  Row height box  and click  OK . Save the workbook. 
    You increased the height of the row that contains the worksheet title so that it is more prominent.    

Step b: ScreenTip when
setting width

Step d: Row height increased

  FIGURE  27  Column Width 
and Row Height Changed       

  STEP 5 ››   ADJUST COLUMN WIDTH AND ROW HEIGHT 
 As you review your worksheet, you notice that the labels in column A appear cut off. You need to increase the width of 
that column to display the entire product names. In addition, you want to make row 1 taller. Refer to  Figure    27    as you 
complete Step 5.  
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a.   Click the  column C heading , the column containing the Markup Rate values.  

  b.   Press and hold  Ctrl  as you click the  column E heading  and the  column H heading . Release 
Ctrl after selecting the headings. 

    Holding down Ctrl enables you to select nonadjacent ranges. You want to hide the rate 
columns temporarily.  

  c.   Click  Format  in the Cells group, point to  Hide & Unhide , and then select  Hide Columns . 

    Excel hides the selected columns. You see a gap in column heading letters, indicating 
columns are hidden (refer to  Figure    28   ).  

  d.   Drag to select the  column G and I headings . 

    You want to unhide column H, so you must select the columns on both sides of the hidden 
column.  

  e.   Click  Format  in the Cells group, point to  Hide & Unhide , and then select  Unhide Columns . 

    Column H, which contains the Profit Margin values, is no longer hidden. You will keep 
the other columns hidden and save the workbook as evidence that you know how to hide 
columns. You will unhide the remaining columns in the next Hands-On Exercise.  

  f.   Save the workbook. Keep the workbook open if you plan to continue with the next 
Hands-On Exercise. If not, close the workbook and exit Excel.         

  STEP 6 ››   HIDE AND UNHIDE COLUMNS 
 To focus on the dollar amounts, you decide to hide the markup rate, discount rate, and profit margin columns. Refer 
to  Figure    28    as you complete Step 6.  

Steps a–c: Columns
C and E hidden

Steps d–e: Column
H unhidden

  FIGURE  28  Hidden and 
Unhidden Columns       

M07_GRAU2679_01_SE_E01_PCL.indd   405 7/25/13   2:40 PM



Introduction to Excel406

Clipboard Tasks 
 Although you plan worksheets before entering data, you might decide to move data to a 
 different location in the same worksheet or even in a different worksheet. Instead of deleting 
the original data and then typing it in the new location, you can select and move data from 
one cell to another. In some instances, you might want to create a copy of data entered so 
that you can explore different values and compare the results of the original data set and the 
copied and edited data set. 

 In this section, you will learn how to select different ranges. Then you will learn how to 
move a range to another location, make a copy of a range, and use the Paste Special feature. 

Selecting, Moving, Copying, and 
Pasting Data 
 You may already know the basics of selecting, cutting, copying, and pasting data in other pro-
grams, such as Microsoft Word. These tasks are somewhat different when working in Excel. 

Select a Range 
       A  range  refers to a group of adjacent or contiguous cells. A range may be as small as a single 
cell or as large as the entire worksheet. It may consist of a row or part of a row, a column or 
part of a column, or multiple rows or columns, but will always be a rectangular shape, as you 
must select the same number of cells in each row or column for the entire range. A range is 
specified by indicating the top-left and bottom-right cells in the selection. For example, in 
 Figure    29   , the date is a single-cell range in cell A2, the Colour Laser Printer data are stored 
in the range A6:G6, the cost values are stored in the range B5:B10, and the sales prices and 
profit margins are stored in range F5:G10. A  nonadjacent range  contains multiple ranges, 
such as B5:B10 and F5:G10. At times, you need to select nonadjacent ranges so that you 
can apply the same formatting at the same time, such as formatting the nonadjacent range 
C5:C10 and E5:E10 with Percent Style.  

STEP 1››

Range of cells

Single-cell range

Range in a row

Range in a column

Quick Analysis button

9/1/2016

  Table    4    lists methods you can use to select ranges, including nonadjacent ranges.  

FIGURE  29  Sample Ranges       
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 A green border appears around a selected range, and the Quick Analysis button displays 
in the bottom-right corner of the selected range. Any command you execute will affect the 
entire range. The range remains selected until you select another range or click in any cell in 
the worksheet.     

 TABLE  4   Selecting Ranges 
 To Select:  Do This: 

 A range 
 Drag until you select the entire range. Alternatively, 
click the first cell in the range, press and hold Shift, 
and then click the last cell in the range. 

 An entire column  Click the column heading. 

 An entire row  Click the row heading. 

 Current range containing data  Click in the range of data and press Ctrl+A. 

 All cells in a worksheet  Click Select All or press Ctrl+A twice. 

 Nonadjacent range 
 Select the first range, press and hold Ctrl, and then 
select additional range(s). 

   Name Box 

 You can use the Name Box to select a range by clicking in the Name Box, typing a range 
address such as B15:D25, and then pressing Enter. 

   TIP 

  Move a Range to Another Location 
       You can move cell contents from one range to another. For example, you might need to move 
an input area from the right side of the worksheet to above the output range. When you 
move a range containing text and values, the text and values do not change. However, any 
formulas that refer to cells in that range will update to reflect the new cell addresses. To move 
a range, do the following: 

   1.   Select the range.  
  2.   Use the Cut command to copy the range to the Clipboard. Unlike cutting data in 

other Microsoft Office applications, the data you cut in Excel remain in their locations 
until you paste them elsewhere. After you click Cut, a moving dashed green border 
surrounds the selected range and the status bar displays  Select destination and press 
ENTER or choose Paste .  

  3.   Make sure the destination range—the range where you want to move the data—is the 
same size or greater than the size of the cut range. If any cells within the destination 
range contain data, Excel overwrites that data when you use the Paste command.  

  4.   Click in the top-left corner of the destination range, and then use the Paste command 
to insert the data contained in the selected range and remove that data from the 
original range.    

  Copy and Paste a Range 
       You may need to copy cell contents from one range to another. For example, you might copy 
your January budget to another worksheet to use as a model for creating your February bud-
get. When you copy a range, the original data remain in their original locations. Cell refer-
ences in copied formulas adjust based on their relative locations to the original data. To copy 
a range, do the following: 

STEP 1››

STEP 2››
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1.   Select the range.  
  2.   Use the Copy command to copy the contents of the selected range to the Clipboard. 

After you click Copy, a moving dashed green border surrounds the selected range and 
the status bar displays  Select destination and press ENTER or choose Paste .  

  3.   Make sure the destination range—the range where you want to copy the data—is the 
same size or greater than the size of the copied range. If any cells within the destination 
range contain data, Excel overwrites that data when you use the Paste command.  

  4.   Click in the top-left corner of the destination range where you want the duplicate data, 
and then use the Paste command. The original range still has the moving dashed green 
border, and the pasted copied range is selected with a solid green border.  Figure    30    
shows a selected range and a copy of the range.  

  5.   Press Esc to turn off the moving dashed border around the originally selected range.        

   Copy as Picture 

 Instead of clicking Copy, if you click the Copy arrow in the Clipboard group, you can select 
Copy (the default option) or Copy as Picture. When you select Copy as Picture, you copy 
an image of the selected data. You can then paste the image elsewhere in the workbook 
or in a Word document or PowerPoint presentation. However, when you copy the data as 
an image, you cannot edit individual cell data after you paste the image. 

   TIP 

  Use Paste Options and Paste Special   
       Sometimes you might want to paste data in a different format than they are in the Clipboard. 
For example, you might want to copy a range containing formulas and cell references, and 
paste the range as values in another workbook that does not have the referenced cells. If you 
want to copy data from Excel and paste them into a Word document, you can paste the Excel 
data as a worksheet object, as unformatted text, or in another format. To paste data from the 
Clipboard into a different format, click the Paste arrow in the Clipboard group, and hover over 

STEP 3››

Click to Copy

Click to Paste

Click to see paste options

Original range

Duplicate data pasted here

Instructions on status bar

FIGURE  30  Copied and 
Pasted Range       
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a command to see a ScreenTip and a preview of how the pasted data will look. In  Figure    31   , 
the preview shows that a particular paste option will maintain formulas and number format-
ting; however, it will not maintain the text formatting, such as font colour and centred text. 
After previewing different paste options, click the one you want in order to apply it.  

   Paste Options Button 

 When you copy or paste data, Excel displays the  Paste Options button  in the bottom-
right corner of the pasted data (refer to  Figure    30   ). Click Paste Options to see different 
results for the pasted data. 

   TIP 

  FIGURE  32  Paste Special 
Dialog Box       

 For more specific paste options, click the Paste arrow, and then select Paste Special to 
display the Paste Special dialog box (see  Figure    32   ). This dialog box contains more options 
than the Paste menu. Click the desired option and click OK.         

Click Paste arrow

ScreenTip when mouse
is over option

Displays how pasted data will
look with current Paste option

FIGURE  31  Paste Options and 
Previewed Results       
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Copy Excel Data to Other Programs 
 You can copy Excel data and use it in other applications, such as in a Word document or in 
a PowerPoint slide show. For example, you might perform statistical analyses in Excel, copy 
the data into a research paper in Word or create a budget in Excel, and then copy the data 
into a PowerPoint slide show for a meeting. 

 After selecting and copying a range in Excel, you must decide how you want the data to 
appear in the destination application. Click the Paste arrow in the destination application, 
such as Word, to see a gallery of options or to select the Paste Special option.    

Transposing Columns and Rows 

 After entering data into a worksheet, you might want to transpose the columns and rows 
so that the data in the first column appear as column labels across the first row, or the col-
umn labels in the first row appear in the first column. To transpose worksheet data, select 
and copy the original range, click the top-left corner of the destination range, click the 
Paste arrow, and then click Transpose. 

   TIP 

   1.   When you move or copy a worksheet, what are some of the decisions you must make?      

  2.   How can you select nonadjacent ranges, such as B5:B10 and F5:F10? Why would you select 
nonadjacent ranges?      

  3.   Why would you use the Paste Special options in Excel?       

   Quick 
Concepts 

✓
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 4 Clipboard Tasks 
You realize the 28" Monitor data is in the Furniture category instead of the Electronics category. You need to move the product to 
its appropriate location. In addition, your supervisor will ask you to enter data for a new product. Because it is almost identical to 
an existing product, you can copy the original data and edit the copied data to save time. You also want to experiment with the 
Paste Special option to see the results of using it in the OKOS workbook. 

Skills covered: Select a Range and Move a Row to a New Location • Copy and Paste a Range • Use Paste Special 

STEP 1 ››   SELECT A RANGE AND MOVE A ROW TO A NEW LOCATION 
You want to move the 28" Monitor product to be immediately after the Color Laser Printer product. Before moving 
the 28" Monitor row, you need to insert a blank row between the Color Laser Printer and Furniture rows. Refer to 
Figure    33    as you complete Step 1.  

  Hands-On Exercises 

a.   Open  e01h3Markup_LastFirst  if you closed it at the end of Hands-On Exercise 3 and save it as 
e01h4Markup_LastFirst , changing  h3  to  h4 .  

  b.   Select the  column B ,  D ,  and F headings . Unhide columns C and E as you learned in 
Hands-On Exercise 3. 

    You kept those columns hidden when you saved the  e01h3Markup_LastFirst  workbook to 
preserve evidence that you know how to hide columns. Now you need the columns visible to 
continue.  

  c.   Right-click the  row 8 heading  and select  Insert  from the menu. 

    You need to insert a blank row so that you can move the  28" Computer Monitor  data to be 
between the  Color Laser Printer  and  Furniture  rows.  

  d.   Select the  range A12:H12 . 

    You selected the range of cells containing the 28" Monitor data.  

  e.   Click  Cut  in the Clipboard group. 

    A moving dashed green border outlines the selected range. The status bar displays the 
message  Select destination and press ENTER or choose Paste .  

Step e: Click to cut
original Monitor data

Step g: Click to paste
Monitor data on row 8

Step g: Monitor data
moved to this row

Step d: Row originally
containing monitor data

  FIGURE  33  Row Moved to 
New Location       

HOE4 TrainingWatch the Video 
for this Hands-
On Exercise!
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f.   Click  cell A8 , the new blank row you inserted in step c. 

 This is the first cell in the destination range.  

g.   Click  Paste  in the Clipboard group and save the workbook. 

 The 28" Monitor data are now located on row 8.     

a.   Select the  range A10:H10 , the row containing the Desk Chair product data, and click  Copy  in 
the Clipboard group.  

  b.   Click  cell A12 , the location for the duplicate data, and click  Paste  in the Clipboard group. 
Press  Esc . 

    The pasted range is selected in row 12.  

  c.   Click  cell A12 , press  F2  to activate Edit Mode, press  Home , type  Executive , press  Spacebar , 
and then press  Enter . 

    You edited the product name.  

  d.   Change the value in  cell B12  to  200 . Save the workbook. 

    The formulas calculate the results based on the new cost of 200 for the Executive Desk 
Chair.    

 TROUBLESHOOTING:     If you cut and paste a row without inserting a new row fi rst, Excel 
will overwrite the original row of data, which is why you inserted a new row in step c. If you 
forgot to do step c, click Undo until the 28" Monitor data is back in its original location and 
start with step c again. 

STEP 2 ››   COPY AND PASTE A RANGE 
Alesha told you that a new chair is on its way. She asked you to enter the data for the Executive Desk Chair. Because 
most of the data is the same as the Desk Chair data, you will copy the original Desk Chair data, edit the product 
name, and then change the cost to reflect the cost of the second chair. Refer to  Figure    34    as you complete Step 2.  

Steps b–c: Duplicate range pasted
here and edited product name

Step a: Click to Copy

Step d: Edited cost

FIGURE  34  Data Copied and 
Edited       
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a.   Click  cell A1 . Apply these font formats to the title:  14 pt ,  Bold , and  Gold, Accent 4, Darker 
50% font colour  in the Font group on the HOME tab. 

    You need to format text to see the effects of using different Paste Special options.  

  b.   Select the  range A1:H12  and click  Copy  in the Clipboard group.  

  c.   Click  cell A15 , the top-left corner of the destination range.  

  d.   Click the  Paste arrow  in the Clipboard group and position the mouse pointer over  Formulas . 

    Without clicking the command, Excel shows you a preview of what that option would do. 
The pasted copy would not contain the font formatting you applied to the title or the bold 
on the two category names. In addition, the pasted date would appear as a serial number. 
The formulas would be maintained.  

  e.   Position the mouse pointer over  Values & Source Formatting . 

    This option would preserve the formatting, but it would convert the formulas into the 
current value results.  

  f.   Click  Values & Source Formatting , click  cell H6  to see a formula, and then click  cell H20 . 
Press  Esc  to turn off the border. 

    Cell H6 contains a formula, but in the pasted version, the equivalent cell H20 has converted 
the formula result into an actual value. If you were to change the original cost on row 20, the 
contents of cell H20 would not change. In a working environment, this is useful only if you 
want to capture the exact value in a point in time before making changes to the original data.  

  g.   Save the workbook. Keep the workbook open if you plan to continue with the next 
Hands-On Exercise. If not, close the workbook and exit Excel.         

STEP 3 ››   USE PASTE SPECIAL 
During your lunch break, you want to experiment with some of the Paste Special options. Particularly, you are 
interested in pasting Formulas and Value & Source Formatting. First, you will bold the title and apply a font colour 
to help you test these Paste Special options. Refer to  Figure    35    as you complete Step 3.  

Step a: Formatted title

Step b: Click to copy
selected range

Step f: Value pasted
instead of formula

Step d: Click to see Paste
Special options

Step f: Formatting maintained

FIGURE  35  Paste Special 
Results       
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Formatting 
 After entering data and formulas, you should format the worksheet. A professionally format-
ted worksheet—through adding appropriate symbols, aligning decimals, and using fonts and 
colours to make data stand out—makes finding and analyzing data easy. You apply different 
formats to accentuate meaningful details or to draw attention to specific ranges in a worksheet. 

 In this section, you will learn to apply different alignment options, including horizontal 
and vertical alignment, text wrapping, and indent options. In addition, you will learn how to 
format different types of values. 

Applying Alignment and Font Options 
Alignment  refers to how data are positioned in cells. Text aligns at the left cell margin, and 
dates and values align at the right cell margin. You can change the alignment of cell contents to 
improve the appearance of data within the cells. The Alignment group (see  Figure    36   ) on the 
Home tab contains several features to help you align and format data.     

   Alignment Options 

 The Format Cells dialog box contains additional alignment options. To open the Format 
Cells dialog box, click the Dialog Box Launcher in the Alignment group on the Home tab. 
The Alignment tab in the dialog box contains the options for aligning data. 

   TIP 

Vertical alignment

Wrap Text

Horizontal alignment

Indent options

Fill colour applied to cells

Labels centred and wrapped

Border surrounding a range

Indented cell contents

Main title merged and
centred over columns

Merge & Center

  FIGURE  36  Alignment 
Options       

Merge and Centre Labels 
       You may want to place a title at the top of a worksheet and centre it over the columns of data 
in the worksheet. You can centre main titles over all columns in the worksheet, and you can 
centre category titles over groups of related columns. To create a title, enter the text in the 
far left cell of the range. Select the range of cells across which you want to centre the title and 
click Merge & Center in the Alignment group on the Home tab. Only data in the far left cell 
(or top right cell) are merged. Any other data in the merged cells are deleted. Excel merges 
the selected cells together into one cell, and the merged cell address is that of the original cell 
on the left. The data are centred between the left and right sides of the merged cell.  

 If you merge too many cells and want to split the merged cell back into its original mul-
tiple cells, click the merged cell and click Merge & Center. Unmerging places the data in the 
top-left cell. 

STEP 1››
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 For additional options, click the Merge & Center arrow.  Table    5    lists the four merge 
options.   

   Rotate Cell Data 

 People sometimes rotate headings in cells. You can rotate data in a cell by clicking 
Orientation in the Alignment group and selecting an option, such as Angle Clockwise. 

   TIP 

 TABLE  5   Merge Options 
 Option  Results 

 Merge & Center  Merges selected cells and centres data into one cell. 

 Merge Across 
 Merges the selected cells but keeps text left-aligned or values 
right-aligned. 

 Merge Cells 
 Enables you to merge a range of cells on multiple rows as well as 
in multiple columns. 

 Unmerge Cells  Separates a merged cell into multiple cells again. 

  Change Horizontal and Vertical Cell Alignment 
  Horizontal alignment  specifies the position of data between the left and right cell margins, 
and  vertical alignment  specifies the position of data between the top and bottom cell margins. 
Bottom Align is the default vertical alignment (as indicated by the light green background), 
and Align Left is the default horizontal alignment for text. In  Figure    36   , the labels on row 4 
have Center horizontal alignment and the title in row 1 has Middle Align vertical alignment. 

 If you increase row height, you might need to change the vertical alignment to position 
data better in conjunction with data in adjacent cells. To change alignments, click the desired 
alignment setting(s) in the Alignment group on the Home tab.     

STEP 2››

  Wrap Text 
       Sometimes you have to maintain specific column widths, but the data do not fit entirely. You 
can use  wrap text  to make data appear on multiple lines by adjusting the row height to fit the 
cell contents within the column width. When you click Wrap Text in the Alignment group, 
Excel wraps the text on two or more lines within the cell. This alignment option is helpful 
when the column headings are wider than the values contained in the column. In  Figure    36   , 
the  Markup Rate  and  Percent Off  labels on row 4 are examples of wrapped text.  

  Increase and Decrease Indent 
       To offset labels, you can indent text within a cell.  Indenting  helps others see the hierarchi-
cal structure of data. Accountants often indent the word  Totals  in financial statements so 
that it stands out from a list of items above the total row. To indent the contents of a cell, 
click Increase Indent in the Alignment group on the Home tab. The more you click Increase 
Indent, the more text is indented in the cell. To decrease the indent, click Decrease Indent in 
the Alignment group. In  Figure    36   ,  Computer System  and  Desk Chair  are indented.     

STEP 2››

STEP 3››
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   Indenting Values 

 Values right-align by default. You should align the decimal places in a column of values. If 
the column label is wide, the values below it appear too far on the right. To preserve the 
values aligning at the decimal places, use the Align Right horizontal alignment and click 
Increase Indent to shift the values over to the left a little for better placement. 

   TIP 

Apply Borders and Fill Colour 
       You can apply a border or fill colour to accentuate data in a worksheet. A  border  is a line 
that surrounds a cell or a range of cells. You can use borders to offset some data from the 
rest of the worksheet data. To apply a border, select the cell or range that you want to have a 
border, click the Borders arrow in the Font group, and then select the desired border type. In 
 Figure    36   , a border surrounds the range E4:F12. To remove a border, select No Border from 
the Borders menu. 

 To add some colour to your worksheet to add emphasis to data or headers, you can apply a 
fill colour.  Fill colour  is a background colour that displays behind the data. You should choose a 
fill colour that contrasts with the font colour. For example, if the font colour is Black, you might 
want to choose Yellow fill colour. If the font colour is White, you might want to apply Blue or 
Dark Blue fill colour. To apply a fill colour, select the cell or range that you want to have a fill 
colour, click the Fill Color arrow on the Home tab, and then select the colour choice from the 
Fill Color palette. In  Figure    36   , the column labels in row 4 contain the Gold, Accent 4, Lighter 
80% fill colour. If you want to remove a fill colour, select No Fill from the bottom of the palette. 

 For additional border and fill colour options, click the Dialog Box Launcher in the Font 
group to display the Format Cells dialog box. Click the Border tab to select border options, 
including the border line style and colour. Click the Fill tab to set the background colour, fill 
effects, and patterns.   

Applying Number Formats 
 Values have no special formatting when you enter data. You should apply  number formats
based on the type of values in a cell, such as applying either the Accounting or Currency 
number format to monetary values. Changing the number format changes the way the num-
ber displays in a cell, but the format does not change the number’s value. If, for example, you 
enter 123.456 into a cell and format the cell with the Currency number type, the value shows 
as $123.46 onscreen, but the actual value 123.456 is used for calculations. When you apply a 
number format, you can specify the number of decimal places to display onscreen. 

Apply a Number Format 
       The default number format is General, which displays values as you originally enter them. 
General does not align decimal points in a column or include symbols, such as dollar signs, 
percent signs, or commas.  Table    6    lists and describes the primary number formats in Excel.  

STEP 4››

STEP 5››
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 TABLE  6   Number Formats 
 Format Style  Display 

 General 
 A number as it was originally entered. Numbers are shown as integers (e.g., 12345), decimal fractions 
(e.g., 1234.5), or in scientific notation (e.g., 1.23E+10) if the number exceeds 11 digits. 

 Number 
 A number with or without the 1,000 separator (e.g., a comma) and with any number of decimal places. 
Negative numbers can be displayed with parentheses and/or red. 

 Currency 
 A number with the 1,000 separator and an optional dollar sign (which is placed immediately to the left of 
the number). Negative values are preceded by a minus sign or are displayed with parentheses or in red. 
Two decimal places display by default. 

 Accounting 
Number Format 

 A number with the 1,000 separator, an optional dollar sign (at the left border of the cell, vertically 
aligned within a column), negative values in parentheses, and zero values as hyphens. Two decimal places 
display by default. Changes alignment slightly within the cell. 

 Comma 
 A number with the 1,000 separator. Used in conjunction with Accounting Number Style to align commas 
and decimal places. 

 Date  The date in different ways, such as Long Date (March 14, 2016) or Short Date (3/14/16 or 14-Mar-16). 

 Time  The time in different formats, such as 10:50 PM or 22:50. 

 Percent Style 

 The value as it would be multiplied by 100 (for display purpose), with the percent sign. The default 
number of decimal places is zero if you click Percent Style in the Number group or two decimal places 
if you use the Format Cells dialog box. However, you should typically increase the number of decimal 
points to show greater accuracy. 

 Fraction 
 A number as a fraction; use when no exact decimal equivalent exists. A fraction is entered into a cell as a 
formula such as =1/3. If the cell is not formatted as a fraction, the formula results display. 

 Scientific 

 A number as a decimal fraction followed by a whole number exponent of 10; for example, the number 
12345 would appear as 1.23E+04. The exponent, +04 in the example, is the number of places the 
decimal point is moved to the left (or right if the exponent is negative). Very small numbers have 
negative exponents. 

 Text 
 The data left aligned; is useful for numerical values that have leading zeros and should be treated as text, 
such as postal codes or phone numbers. Apply Text format before typing a leading zero so that the zero 
displays in the cell. 

 Special  A number with editing characters, such as hyphens in a Social Insurance Number. 

 Custom 
 Predefined customized number formats or special symbols to create your own customized number 
format. 

 The Number group on the Home tab contains commands for applying  Accounting 
Number Format ,  Percent Style , and  Comma Style  numbering formats. You can click the 
Accounting Number Format arrow and select other denominations, such as English 
pounds or euros. For other number formats, click the Number Format arrow and select the 
 numbering format you want to use. For more specific numbering formats than those pro-
vided, select More Number Formats from the Number Format menu or click the Number 
Dialog Box Launcher to open the Format Cells dialog box with the Number tab options 
readily available.  Figure    37    shows different number formats applied to values.   

  FIGURE  37  Number Formats       
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   1.   What is the importance of formatting a worksheet?      

  2.   Describe five alignment and font formatting techniques used to format labels that are 
discussed in this section.      

  3.   What are the main differences between Accounting Number Format and Currency 
format? Which format has its own command on the Ribbon?       

   Quick 
Concepts 

✓

Increase and Decrease Decimal Places 
       After applying a number format, you may need to adjust the number of decimal places 
that display. For example, if you have an entire column of monetary values formatted in 
Accounting Number Format, Excel displays two decimal places by default. If the entire col-
umn of values contains whole dollar values and no cents, displaying  .00  down the column 
looks cluttered. You can decrease the number of decimal places to show whole numbers only. 

 To change the number of decimal places displayed, click Increase Decimal in the 
Number group on the Home tab to display more decimal places for greater precision or 
Decrease Decimal to display fewer or no decimal places.    

STEP 5››
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 5 Formatting 
In the first four Hands-On Exercises, you entered data about products on sale, created formulas to calculate markup and profit, 
and inserted new rows and columns to accommodate the labels  Electronics  and  Furniture  to identify the specific products. You are 
ready to format the worksheet. Specifically, you need to centre the title, align text, format values, and then apply other formatting 
to enhance the readability of the worksheet. 

 Skills covered: Merge and Centre the Title • Align Text Horizontally and Vertically and Wrap Text • Increase Indent • Apply Borders 
and Fill Colour • Apply Number Formats and Increase and Decrease Decimal Places 

STEP 1 ››   MERGE AND CENTRE THE TITLE 
To make the title stand out, you want to centre it over all the data columns. You will use the Merge & Center 
command to merge cells and centre the title at the same time. Refer to  Figure    38    as you complete Step 1.  

  Hands-On Exercises 

a.   Open  e01h4Markup_LastFirst  if you closed it at the end of Hands-On Exercise 4 and save it as 
e01h5Markup_LastFirst , changing  h4  to  h5 .  

  b.   Select the  range A15:H26  and press  Delete . 

    You maintained a copy of your Paste Special results in the  e01h4Markup_LastFirst  
workbook, but you do not need it to continue.  

  c.   Select the  range A1:H1 . 

    You want to centre the title over all columns of data.  

  d.   Click  Merge & Center  in the Alignment group. 

    Excel merges cells in the range A1:H1 into one cell and centres the title horizontally within 
the merged cell, which is cell A1.   

 TROUBLESHOOTING:     If you merge too many or not enough cells, you can unmerge 
the cells and start again. To unmerge cells, click in the merged cell. The Merge & Center 
command is shaded in green when the active cell is merged. Click Merge & Center to 
unmerge the cell. Then select the correct range to merge and use Merge & Center again. 

Step e: Date merged,
centred, and bold A2:H2

  FIGURE  38  Title and Date 
Merged and Centred       

HOE5 TrainingWatch the Video 
for this Hands-
On Exercise!
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e.   Select the  range A2:H2 . Merge and centre the date and bold it.   

f.   Save the workbook.    

 TROUBLESHOOTING:     If you try to merge and centre data in the range A1:H2, Excel will 
keep the top-left data only and delete the date. To merge separate data on separate rows, 
you must merge and centre data separately. 

STEP 2 ››   ALIGN TEXT HORIZONTALLY AND VERTICALLY AND WRAP TEXT 
You will wrap the text in the column headings to avoid columns that are too wide for the data, but which will display 
the entire text of the column labels. In addition, you will horizontally centre column labels between the left and right 
cell margins. Refer to  Figure    39    as you complete Step 2.  

a.   Select the  range A4:H4  to select the column labels.  

b.   Click  Wrap Text  in the Alignment group. 

    The multiple-word column headings are now visible on two lines within each cell.  

  c.   Click  Center  in the Alignment group. Bold the selected column headings. 

    The column headings are centred horizontally between the left and right edges of each cell.  

  d.   Click  cell A1 , which contains the title, click  Middle Align  in the Alignment group, and then 
save the workbook. 

    Middle Align vertically centres data between the top and bottom edges of the cell.    

  STEP 3 ››   INCREASE INDENT 
 As you review the first column, you notice that the category names, Electronics and Furniture, do not stand out. 
You decide to indent the labels within each category to better display which products are in each category. Refer 
to  Figure    40    as you complete Step 3.  

Steps b–c: Column labels
wrapped, centred, and bold

Step d: Title with Middle
(vertical) Align

FIGURE  39  Formatted 
Column Labels       
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   a.   Select the  range A4:H4  and click the  Fill Color arrow  in the Font group.  

  b.   Click  Gold, Accent 4, Lighter 80%  in the  Theme Colors  section. It is the second colour 
down in the third column from the right. 

    You applied a fill colour to the selected cells to draw attention to these cells.  

   a.   Select the  range A6:A8 , the cells containing electronic products labels.  

  b.   Click  Increase Indent  in the Alignment group twice. 

 The three selected product names are indented below the  Electronics  heading.  

  c.   Select the  range A10:A12 , the cells containing furniture products, and click  Increase Indent  
twice. 

    The three selected product names are indented below the  Furniture  heading. Notice that the 
one product name appears cut off.  

d.   Increase the column A width to  26.00 . Save the workbook.    

STEP 4 ››   APPLY BORDERS AND FILL COLOUR 
You want to apply a light gold fill colour to highlight the column headings. In addition, you want to emphasize 
the percent off and sale prices. You will do this by applying a border around that range. Refer to  Figure    41    as you 
complete Step 4.  

Step b: Gold,
Accent 4, Lighter 80%

Step c: Thick
Box Border applied

FIGURE  41  Border and Fill 
Colour Applied       

Step d: Column A width
increased to 26.00

Step b: Electronics product
labels indented twice

Step c: Furniture product
labels indented twice

FIGURE  40  Indented Cell 
Contents       
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c.   Select the  range E4:F12 , click the  Border arrow  in the Font group, and then select  Thick 
Box Border . 

 You applied a border around the selected cells.  

d.   Click in an empty cell below the columns of data to deselect the cells. Save the workbook.    

a.   Select the  range B6:B12.  Press and hold  Ctrl  as you select the  ranges D6:D12  and  F6:G12 . 

    Because you want to format nonadjacent ranges with the same formats, you hold down Ctrl.  

  b.   Click  Accounting Number Format  in the Number group. If some cells contain pound signs, 
increase the column widths as needed. 

    You formatted the selected nonadjacent ranges with the Accounting Number Format. The 
dollar signs align on the left cell margins and the decimals align.  

  c.   Select the  range C6:C12  and click  Percent Style  in the Number group. 

 You formatted the values in the selected ranges with Percent Style, showing whole numbers 
only.  

d.   Click  Increase Decimal  in the Number group. 

    You increased the decimal to show one decimal place to avoid misleading your readers by 
displaying the values as whole percentages.  

  e.   Apply  Percent Style  to the  range E6:E12 .  

f.   Select the  range H6:H12 , apply  Percent Style , and then click  Increase Decimal .  

  g.   Select the  range E6:E12 , click  Align Right , and then click  Increase Indent  twice. Select the 
 range H6:H12 , click  Align Right , and then click  Increase Indent . 

 With values, you want to keep the decimal points aligned, but you can then use Increase 
Indent to adjust the indent so that the values appear more centred below the column labels.  

h.   Save the workbook. Keep the workbook open if you plan to continue with the next 
Hands-On Exercise. If not, close the workbook and exit Excel.         

STEP 5 ››   APPLY NUMBER FORMATS AND INCREASE AND DECREASE 
DECIMAL PLACES 

You need to format the values to increase readability and look more professional. You will apply number formats and 
adjust the number of decimal points displayed. Refer to  Figure    42    as you complete Step 5.  

Step e: Percent Style

Step f: Percent Style,
Align Right, Indent twice

Steps c–d: Percent Style
with one decimal place

Step b: Accounting
Number Format

FIGURE  42  Number Formats 
and Decimal Places       
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  Specify Page Options 
       To apply several page setup options at once or to access options not found on the Ribbon, 
click the Page Setup Dialog Box Launcher. The Page Setup dialog box organizes options into 
four tabs: Page, Margins, Header/Footer, and Sheet. All tabs contain Print and Print Preview 
buttons.  Figure    44    shows the Page tab.  

STEP 1››

Page Setup and Printing 
 Although you might distribute workbooks electronically as e-mail attachments or you might 
upload workbooks to a corporate server, you should prepare the worksheets in the workbook 
for printing. You should prepare worksheets in case you need to print them or in case others 
who receive an electronic copy of your workbook need to print the worksheets. The Page 
Layout tab provides options for controlling the printed worksheet (see  Figure    43   ).  

 In this section, you will select options on the Page Layout tab. Specifically, you will use 
the Page Setup, Scale to Fit, and Sheet Options groups. After selecting page setup options, 
you are ready to print your worksheet. 

  Selecting Page Setup Options 
 The Page Setup group on the Page Layout tab contains options to set the margins, select 
orientation, specify page size, select the print area, and apply other options. The  Scale to 
Fit  group contains options for adjusting the scaling of the spreadsheet on the printed page. 
When possible, use the commands in these groups to apply page settings.  Table    7    lists and 
describes the commands in the Page Setup group.  

 TABLE  7   Page Setup Commands 
 Command  Description 

 Margins 
 Displays a menu to select predefined margin settings. The default margins are 1.9 cm (0.75") top and 
bottom and 1.78 cm (0.7") left and right. You will often change these margin settings to balance the 
worksheet data better on the printed page. If you need different margins, select Custom Margins. 

 Orientation 

 Displays orientation options. The default page orientation is portrait, which is appropriate for 
worksheets that contain more rows than columns. Select landscape orientation when worksheets contain 
more columns than can fit in portrait orientation. For example, the OKOS worksheet might appear 
better balanced in landscape orientation because it has eight columns. 

 Size 
 Displays a list of standard paper sizes. The default size is 21.59 cm x 27.94 cm (8.5” x 11”). If you have a 
different paper size, such as legal paper, select it from the list. 

 Print Area 

 Displays a list to set or clear the print area. When you have very large worksheets, you might want to 
print only a portion of that worksheet. To do so, select the range you want to print, click Print Area 
in the Page Setup group, and then select Set Print Area. When you use the Print commands, only the 
range you specified will be printed. To clear the print area, click Print Area and select Clear Print Area. 

 Breaks  Displays a list to insert or remove page breaks. 

 Background 
 Enables you to select an image to appear as the background behind the worksheet data when viewed 
onscreen (backgrounds do not appear when the worksheet is printed). 

 Print Titles  Enables you to select column headings and row labels to repeat on multiple-page printouts. 

  FIGURE  43  Page Layout Tab       
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Click to see a preview of
how the worksheet will

print with the current settings

Select Portrait for worksheets
that have more rows than

columns

Select Landscape for
worksheets that have

more columns than rows

 The Page tab contains options to select the orientation and paper size. In addition, it 
contains scaling options that are similar to the options in the  Scale to Fit  group on the Page 
Layout tab. You use scaling options to increase or decrease the size of characters on a printed 
page, similar to using a zoom setting on a photocopy machine. You can also use the  Fit to  
option to force the data to print on a specified number of pages.  

Set Margins Options 
       The Margins tab (see  Figure    45   ) contains options for setting the specific margins. In  addition, 
it contains options to centre the worksheet data horizontally or vertically on the page. To bal-
ance worksheet data equally between the left and right margins, Excel users often centre the 
page horizontally.    

STEP 2››

FIGURE  44  Page Setup Dialog 
Box—Page Tab       

Select option(s) to centre
worksheet data between

the margins

FIGURE  45  Page Setup Dialog 
Box—Margins Tab       

Excel fi gures in this Canadian 

edition refl ect metric units of mea-

surement, and metric equivalents 

have been added to all instructions. 

To choose metric as a preference: 

In Windows 8:

1.  Move the mouse pointer to the 

upper-right corner of the screen, 

click Settings, then Control Panel.
2.  Under Clock, Language, and 

Region, click Add a language.

3. Double-click English.

4. Double-click English (Canada).

5.  Click English (Canada) and then 

click Move up until it is at the top.

In Windows 7:

1.  Click the Start button and then 

select Control Panel.
2.  Click Clock, Language, and Region.

3.  Under Region and Language, 

click Change date, time or 
number formats.

4.  Pull down the Format menu and 

select English (Canada).

5. Click the OK button.

M07_GRAU2679_01_SE_E01_PCL.indd   424 7/25/13   2:40 PM



Page Setup and Printing • Excel 2013 425

 Instead of creating headers and footers using the Page Setup dialog box, you can click 
the Insert tab and click Header & Footer in the Text group. Excel displays the worksheet in 
Page Layout view with the insertion point in the centre area of the header. You can click 
inside the left, centre, or right section of a header or footer. When you do, Excel displays the 
Header & Footer Tools Design contextual tab (see  Figure    47   ). You can enter text or insert 
data from the Header & Footer Elements group on the tab.  Table    8    lists and describes the 
options in the Header & Footer Elements group. To get back to Normal view, click any cell in 
the worksheet and click Normal in the Workbook Views group on the View tab.       

Create Headers and Footers 
       The Header/Footer tab (see  Figure    46   ) lets you create a header and/or footer that appears at the 
top and/or bottom of every printed page. Click the arrows to choose from several preformatted 
entries, or, alternatively, you can click Custom Header or Custom Footer, insert text and other 
objects, and then click the appropriate formatting button to customize your headers and footers. 
You can use headers and footers to provide additional information about the worksheet. You can 
include your name, the date the worksheet was prepared, and page numbers, for example. 

 You can create different headers or footers on different pages, such as one header with the 
file name on odd-numbered pages and a header containing the date on even-numbered pages. 
Click the  Different odd and even pages  check box in the Page Setup dialog box (see  Figure    46   ). 

 You might want the first page to have a different header or footer from the rest of the 
printed pages, or you might not want a header or footer to show up on the first page but want 
the header or footer to display on the remaining pages. Click the  Different first page  check box 
in the Page Setup dialog box to specify a different first page header or footer (see  Figure    46   ).  

STEP 3››

Specify if you want the first
page to have a different
header/footer from the

rest of the pages

Click to see list of
preformatted headers

Specify if you want a
different header/footer on

odd and even pages

FIGURE  46  Page Setup Dialog 
Box—Header/Footer Tab       

Design tab options

Header & Footer Tools
Design contextual tab

Click here to display
contextual tab

  FIGURE  47  Header & Footer 
Tools Design Contextual Tab       
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 TABLE  8   Header & Footer Elements Options 
 Option Name  Result 

 Page Number  Inserts the code &[Page] to display the current page number. 

 Number of Pages  Inserts the code &[Pages] to display the total number of pages that will print. 

 Current Date 
 Inserts the code &[Date] to display the current date, such as 5/19/2016. The date updates to the current 
date when you open or print the worksheet. 

 Current Time 
 Inserts the code &[Time] to display the current time, such as 5:15 PM. The time updates to the current 
time when you open or print the worksheet. 

 File Path 
 Inserts the code &[Path]&[File] to display the path and file name, such as C:\Documents\e01h4Markup. 
This information changes if you save the workbook with a different name or in a different location. 

 File Name 
 Inserts the code &[File] to display the file name, such as e01h4Markup. This information changes if you 
save the workbook with a different name. 

 Sheet Name 
 Inserts the code &[Tab] to display the worksheet name, such as September. This information changes if 
you rename the worksheet. 

 Picture  Inserts the code &[Picture] to display and print an image as a background behind the data, not just the worksheet. 

 Format Picture  Enables you to adjust the brightness, contrast, and size of an image after you use the Picture option. 

  Select Sheet Options 
       The Sheet tab (see  Figure    48   ) contains options for setting the print area, print titles, print 
options, and page order. Some of these options are also located in the Sheet Options group on 
the Page Layout tab on the Ribbon. By default, Excel displays gridlines onscreen to show you 
each cell’s margins, but the gridlines do not print unless you specifically select the Gridlines 
check box in the Page Setup dialog box or the Print Gridlines check box in the Sheet Options 
group on the Page Layout tab. In addition, Excel displays row (1, 2, 3, etc.) and column 
(A, B, C, etc.) headings onscreen. However, these headings do not print unless you click the 
 Row and column headings  check box in the Page Setup dialog box or click the Print Headings 
check box in the Sheet Options group on the Page Layout tab.     

STEP 5››

   View Tab 

 If you click the View tab and click Page Layout, Excel displays an area  Click to add header  
at the top of the worksheet. 

   TIP 

Click to print gridlines

Click to print row numbers
and column letters

FIGURE  48  Page Setup Dialog 
Box—Sheet Tab       
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Previewing and Printing a Worksheet 
       Before printing a worksheet, you should click the File tab and select Print. The Microsoft 
Office Backstage view displays print options and displays the worksheet in print preview 
mode. This mode helps you see in advance if the data are balanced on the page or if data will 
print on multiple pages. 

 You can specify the number of copies to print and which printer to use to print the 
worksheet. The first option in the Settings area enables you to specify what to print. 
The default option is Print Active Sheets. You can choose other options, such as Print Entire 
Workbook or Print Selection. You can also specify which pages to print. If you are connected 
to a printer capable of duplex printing, you can print on only one side or print on both sides. 
You can also collate, change the orientation, specify the paper size, adjust the margins, and 
adjust the scaling. 

 The bottom of the Print window indicates how many pages will print. If you do not like 
how the worksheet will print, click the Page Layout tab so that you can adjust margins, scaling, 
column widths, and so on until the worksheet data appear the way you want them to print.        

STEP 4››

   Printing Gridlines and Headings 

 For most worksheets, you do not need to print gridlines and row/column headings. 
However, when you want to display and print cell formulas instead of formula results, you 
might want to print the gridlines and row/column headings. Doing so will help you analyze 
your formulas. The gridlines help you see the cell boundaries, and the headings help you 
identify what data are in each cell. At times, you might want to display gridlines to sepa-
rate data on a regular printout to increase readability. 

   TIP 

   Printing Multiple Worksheets 

 To print more than one worksheet at a time, select the sheets you want to print. To select 
adjacent sheets, click the first sheet tab, press and hold Shift, and then click the last sheet 
tab. To select nonadjacent sheets, press and hold Ctrl as you click each sheet tab. When 
you display the Print options in the Microsoft Office Backstage view, Print Active Sheets is 
one of the default settings. If you want to print all of the worksheets within the workbook, 
change the setting to Print Entire Workbook. 

   TIP 

   1.   What helps determine whether you use portrait or landscape orientation for a worksheet?      

  2.   Why would you select a  Center on page  option if you have already set the margins?      

  3.   List at least five elements you can insert in a header or footer.      

  4.   Why would you want to print gridlines and row and column headings?       

   Quick 
Concepts 

✓

M07_GRAU2679_01_SE_E01_PCL.indd   427 7/25/13   2:40 PM



HOE6 TrainingWatch the Video 
for this Hands-
On Exercise!

Hands-On Exercise 6Hands-On Exercise 6

HOE6 TrainingWatch the Video 
for this Hands-
On Exercise!

 6 Page Setup and Printing 
 You are ready to complete the OKOS worksheet. Before printing the worksheet for your supervisor, you want to make sure the data 
will appear professional when printed. You will adjust some page setup options to put the finishing touches on the worksheet. 

 Skills covered: Set Page Orientation • Set Margin Options • Create a Header • View in Print Preview and Print • Adjust Scaling and 
Set Sheet Options 

   STEP 1 ››   SET PAGE ORIENTATION 
 Because the worksheet has several columns, you decide to print it in landscape orientation. 

  Hands-On Exercises 

   a.   Open  e01h5Markup_LastFirst  if you closed it at the end of Hands-On Exercise 5 and save it as 
 e01h6Markup_LastFirst , changing  h5  to  h6 .  

  b.   Click the  PAGE LAYOUT tab .  

  c.   Click  Orientation  in the Page Setup group.  

  d.   Select  Landscape  from the list. Save the workbook.   

  If you print the worksheet, the data will print in landscape orientation.  

  STEP 2 ››   SET MARGIN OPTIONS 
 You want to set a 1"(2.54 cm) top margin and centre the data between the left and right margins. 

   a.   Click  Margins  in the Page Setup group on the PAGE LAYOUT tab. 

    As you review the list of options, you notice the list does not contain an option to centre the 
worksheet data horizontally.  

  b.   Select  Custom Margins . 

    The Page Setup dialog box opens with the Margins tab options displayed.  

  c.   Click the  Top spin arrow  to display  1 . 

    You set a 1" (2.54 cm) top margin. For the OKOS worksheet, you do not need to change the 
left and right margins because you will centre the worksheet data horizontally between the 
original margins.  

  d.   Click the  Horizontally check box  in the  Center on page  section and click  OK . Save the 
workbook. 

    The worksheet data are centred between the left and right margins.       

   Page Setup Dialog Box 

 You can click the Page Setup Dialog Box Launcher in the Page Setup group to quickly 
display the Page Setup dialog box. From there, you can click the Margins tab and set the 
desired margins. 

   TIP 
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M07_GRAU2679_01_SE_E01_PCL.indd   428 7/25/13   2:40 PM



Hands-On Exercise 6 429

a.   Click the  INSERT tab  and click  Header & Footer  in the Text group. 

    Excel displays the DESIGN tab and the worksheet displays in Page Layout view, which 
displays the header area, margin space, and ruler. The insertion point blinks inside the 
centre section of the header.  

  b.   Click in the left section of the header and type your name.  

  c.   Click in the centre section of the header and click  Sheet Name  in the Header & Footer 
Elements group on the DESIGN tab. 

    Excel inserts the code &[Tab]. This code displays the name of the worksheet. If you change 
the worksheet tab name, the header will reflect the new sheet name.  

  d.   Click in the right section of the header and click  Current Date  in the Header & Footer 
Elements group on the DESIGN tab. 

    Excel inserts the code &[Date]. This code displays the current date based on the computer 
clock when you print the worksheet. If you want a specific date to appear regardless of the 
date you open or print the worksheet, you would have to type that date manually. When you 
click in a different header section, the codes, such as &[Tab], display the actual tab name 
instead of the code.  

  e.   Click in any cell in the worksheet, click  Normal  on the status bar, and then save the 
workbook. 

    Normal view displays the worksheet, but does not display the header or margins.    

  STEP 3 ››   CREATE A HEADER 
 To document the worksheet, you want to include your name, the current date, and the worksheet tab name in a 
header. Refer to  Figure    49    as you complete Step 3.  

Step a: Insert tab

Step b: Type your name here

Step e: Normal view

Step d: Date code

Step c: Click to insert sheet
name code in header

Step d: Click to insert
 date code in header

Step c: Sheet name
or code displays

FIGURE  49  Header       
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a.   Click the  FILE tab  and click  Print . 

    The Microsoft Office Backstage view displays print options and a preview of the worksheet.  

  b.   Verify the Printer box displays the printer that you want to use to print your worksheet.  

  c.   Click  Print  to print the worksheet and save the workbook. 

    Check your printed worksheet to make sure the data are formatted correctly. After you click 
Print, the HOME tab displays. If you decide not to print at this time, click the  Back arrow  to 
display the Ribbon again.    

  STEP 5 ››   ADJUST SCALING AND SET SHEET OPTIONS 
 You want to print a copy of the worksheet formulas to check the logic of the formulas. You need to display the 
formulas, select options to print gridlines and headings, and then decrease the scaling so that the data print on one 
page. Refer to  Figure    51    as you complete Step 5.  

STEP 4 ››   VIEW IN PRINT PREVIEW AND PRINT 
Before printing the worksheet, you should preview it. Doing so helps you detect margin problems and other issues, 
such as a single row or column of data flowing onto a new page. Refer to  Figure    50    as you complete Step 4.  

FIGURE  50  Worksheet in Print 
Preview       
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a.   Press  Ctrl+`  to display cell formulas.  

  b.   Click the  PAGE LAYOUT tab . Click the  Print Gridlines check box  in the Sheet Options 
group and click the  Print Headings check box  in the Sheet Options group. 

    Because you want to print cell formulas, it is helpful to display the gridlines and row and 
column headings on that printout.  

  c.   Click the  FILE tab  and click  Print . 

    The bottom of the Print Preview displays 1 of 2, indicating the worksheet no longer prints 
on one page.  

  d.   Click  Next Page  (the right triangle at the bottom of the Microsoft Office Backstage view) to 
view the contents of the second page and click the  Back arrow  to display the Ribbon again.  

  e.   Click  Margins  in the Page Setup group and select  Narrow .  

  f.   Select the  range B4:H12 , click  Print Area  in the Page Setup group, and then select  Set Print 
Area .  

  g.   Click the  Scale spin arrow  in the  Scale to Fit  group on the PAGE LAYOUT tab until it 
displays  90% . 

    If you want to verify that the worksheet will print on one page, display it in print preview.  

  h.   Save and close the workbook and submit based on your instructor’s directions. 

    Check your printed worksheet to make sure the data are formatted correctly.          

Step e: Narrow margins

Step b: Gridlines and
headings will print

Step a: Cell
formulas displayed

FIGURE  51  Worksheet in Print 
Preview       
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     Chapter Objectives Review 

  6.    Manage worksheets.  
   •   Rename a worksheet: The default worksheet tab name is 

Sheet1, but you can change the name to describe the contents 
of a worksheet.  

  •   Change worksheet tab colour: You can apply different colours 
to the sheet tabs so they stand out.  

  •   Insert and delete a worksheet: You can insert new worksheets 
to include related data within one workbook, or you can 
delete extra worksheets you do not need.  

  •   Move or copy a worksheet: Drag a sheet tab to rearrange the 
worksheets. You can copy a worksheet within a workbook or 
to another workbook.    

  7.    Manage columns and rows.  
   •   Insert cells, columns, and rows: Insert a cell to move the 

remaining cells down or to the right. Insert a new column or 
row for data.  

  •   Delete cells, columns, and rows: You can delete cells, 
columns, and rows you no longer need.  

  •   Adjust column width: Double-click between the column 
headings to widen a column based on the longest item in 
that column, or drag the border between column headings to 
increase or decrease a column width.  

  •   Adjust row height: Drag the border between row headings to 
increase or decrease the height of a row.  

  •   Hide and unhide columns and rows: Hiding rows and 
columns protects confidential data from being displayed.    

  8.    Select, move, copy, and paste data.  
   •   Select a range: A range may be a single cell or a rectangular 

block of cells.  
  •   Move a range to another location: After selecting a range, 

cut it from its location. Then make the top-left corner of the 
destination range the active cell and paste the range there.  

  •   Copy and paste a range: After selecting a range, click Copy, 
click the top-left corner of the destination range, and then 
click Paste to make a copy of the original range.  

  •   Use Paste Options and Paste Special: The Paste Special 
option enables you to specify how the data are pasted into the 
worksheet.  

  •   Copy Excel data to other programs: You can copy Excel 
data and paste it in other programs, such as in Word or 
PowerPoint.    

  9.    Apply alignment and font options.  
   •   Merge and centre labels: Type a label in the left cell, select a 

range including the data you typed, and then click Merge & 
Center to merge cells and centre the label within the newly 
merged cell.  

  •   Change horizontal and vertical cell alignment: The default 
horizontal alignment depends on the data entered, and the 
default vertical alignment is Bottom Align.  

   1.    Explore the Excel window.  
   •   A worksheet is a single spreadsheet containing data. A 

workbook is a collection of one or more related worksheets 
contained in a single file.  

  •   Identify Excel window elements: The Name Box displays 
the name of the current cell. The Formula Bar displays the 
contents of the current cell. The active cell is the current cell. 
A sheet tab shows the name of the worksheet.  

  •   Identify columns, rows, and cells: Columns have alphabetical 
headings, such as A, B, C. Rows have numbers, such as 1, 
2, 3. A cell is the intersection of a column and row and is 
indicated like A5.  

  •   Navigate in and among worksheets: Use the arrow keys to 
navigate within a sheet, or use the Go To command to go 
to a specific cell. Click a sheet tab to display the contents on 
another worksheet.    

  2.    Enter and edit cell data.  
   •   You should plan the worksheet design by stating the purpose, 

deciding what input values are needed, and then deciding 
what outputs are needed. Next, you enter and format data in 
a worksheet. Finally, you document, save, and then share a 
workbook.  

  •   Enter text: Text may contain letters, numbers, symbols, and 
spaces. Text aligns at the left side of a cell.  

  •   Enter values: Values are numbers that represent a quantity. 
Values align at the right side of a cell by default.  

  •   Enter dates: Excel stores dates as serial numbers so that you 
can calculate the number of days between dates.   

  •   Enter formulas: A formula is used to perform calculations. 
The formula results display in the cells.  

  •   Edit and clear contents: You can clear the cell contents and/or 
formats.    

  3.    Create formulas.  
   •   Use cell references in formulas: Use references, such as 

=B5+B6, instead of values within formulas.  
  •   Apply the order of precedence: The most commonly used 

operators are performed in this sequence: Exponentiation, 
Multiplication, Division, Addition, and Subtraction. Use 
parentheses to perform a lower operation first.  

  •   Use semi-selection to create a formula: When building a 
formula, you can click a cell containing a value to enter that 
cell reference in the formula.    

  4.    Use Auto Fill.  
   •   Copy formulas with Auto Fill: To copy a formula down a 

column or across a row, double-click or drag the fill handle.  
  •   Complete sequences with Auto Fill: Use Auto Fill to copy 

formulas, number patterns, month names, etc.    

  5.    Display cell formulas.  
   •   By default, the results of formulas appear in cells.  
  •   You can display formulas by pressing Ctrl+`.    

 After reading this chapter, you have accomplished the following objectives: 
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•   Wrap text: Use the Wrap Text option to present text on 
multiple lines in order to avoid having extra-wide columns.  

  •   Increase and decrease indent: To indicate hierarchy of data or 
to offset a label you can increase or decrease how much the 
data are indented in a cell.  

  •   Apply borders and fill colours: Borders and fill colours help 
improve readability of worksheets.    

  10.    Apply number formats.  
 • The default number format is General, which does not apply 

any particular format to values. Apply appropriate formats 
to values to present the data with the correct symbols and 
decimal alignment. For example, Accounting Number 
Format is a common number format for monetary values. 

   •   Increase and decrease decimal places: After applying a 
number format, you can increase or decrease the number of 
decimal places displayed.    

  11.    Select page setup options.  
   •   The Page Layout tab on the Ribbon contains options for 

setting margins, selecting orientation, specifying page size, 
selecting the print area, and applying other settings.  

  •   Specify page options: Page options include orientation, paper 
size, and scaling.  

  •   Set margin options: You can set the left, right, top, and 
bottom margins. In addition, you can centre worksheet data 
horizontally and vertically on a page.  

  •   Create headers and footers: You can insert a header or footer 
to display documentation, such as your name, date, time, and 
worksheet tab name.  

  •   Select sheet options: Sheet options control the print area, 
print titles, print options, and page order.    

  12.    Preview and print a worksheet.  
   •   Before printing a worksheet, you should display a preview to 

ensure the data will print correctly. The Print Preview helps 
you see if margins are correct or if isolated rows or columns 
will print on separate pages.  

  •   After making appropriate adjustments, you can print the 
worksheet.      
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  Key Terms Matching 

    a.    Alignment      
   b.    Auto Fill      
   c.    Cell      
   d.    Column width      
   e.    Fill colour      
   f.    Fill handle      
   g.    Formula      
   h.    Formula Bar      
   i.    Input area      
   j.    Name Box      

   k.    Order of precedence      
   l.    Output area      
   m.    Range      
   n.    Row height      
   o.    Sheet tab      
   p.    Text      
   q.    Value      
   r.    Workbook      
   s.    Worksheet      
   t.    Wrap text        

  1. _______   A spreadsheet that contains formulas, functions, values, text, and visual aids.      

 2.   _______ A file containing related worksheets.      

   3.   _______ A range of cells containing values for variables used in formulas.      

   4.   _______ A range of cells containing results based on manipulating the variables.      

   5.   _______ Identifies the address of the current cell.      

   6.   _______ Displays the content (text, value, date, or formula) in the active cell.      

   7.   _______ Displays the name of a worksheet within a workbook.      

   8.   _______ The intersection of a column and row.      

   9.   _______ Includes letters, numbers, symbols, and spaces.      

  10.   _______ A number that represents a quantity or an amount.      

  11.   _______ Rules that control the sequence in which Excel performs arithmetic operations.      

  12.    _______  Enables you to copy the contents of a cell or cell range or to continue a sequence by 
dragging the fill handle over an adjacent cell or range of cells.      

  13.   _______ A small green square at the bottom-right corner of a cell.      

  14.   _______ The horizontal measurement of a column.      

  15.   _______ The vertical measurement of a row.      

  16.   _______ A rectangular group of cells.      

  17.   _______ The position of data between the cell margins.      

  18.   _______ Formatting that enables a label to appear on multiple lines within the current cell.      

  19.   _______ The background colour appearing behind data in a cell.      

  20.    _______  A combination of cell references, operators, values, and/or functions used to perform a 
calculation.       

 Match the key terms with their definitions. Write the key term letter by the appropriate numbered 
definition. 
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  Multiple Choice 
 1.  What is the first step in planning an effective worksheet?  

    (a)  Enter labels, values, and formulas.  
   (b)  State the purpose of the worksheet.  
   (c)  Identify the input and output areas.  
   (d)  Decide how to format the worksheet data.    

 2.  What Excel interface item displays the address of the current 
cell?  

    (a)  Quick Access Toolbar  
   (b)  Formula Bar  
   (c)  Status bar  
   (d)  Name Box    

 3.  Given the formula =B1*B2+B3/B4^2 where B1 contains 3, 
B2 contains 4, B3 contains 32, and B4 contains 4, what is the 
result?  

    (a)  14  
   (b)  121  
   (c)  76  
   (d)  9216    

 4.  Why would you press Ctrl+` in Excel?  

    (a)  To display the print options  
   (b)  To undo a mistake you made  
   (c)  To display cell formulas  
   (d)  To enable the AutoComplete feature    

 5.  Which of the following is a nonadjacent range?  

    (a)  C15:D30  
   (b)  L15:L65  
   (c)  A1:Z99  
   (d)  A1:A10, D1:D10    

 6.  If you want to balance a title over several columns, what do 
you do?  

    (a)  Enter the data in the cell that is about midway across the 
spreadsheet.  

   (b)  Merge and centre the data over all columns.  

   (c)  Use the Increase Indent command until the title looks 
balanced.  

   (d)  Click Center to centre the title horizontally over several 
columns.    

     7.  Which of the following characteristics is not applicable to the 
Accounting Number Format?  

    (a)  Dollar sign immediately on the left side of the value  
   (b)  Commas to separate thousands  
   (c)  Two decimal places  
   (d)  Zero values displayed as hyphens    

     8.  You selected and copied worksheet data containing formulas. 
However, you want the pasted copy to contain the current 
formula results rather than formulas. What do you do?  

    (a)  Click Paste in the Clipboard group on the Home tab.  
   (b)  Click the Paste arrow in the Clipboard group and select 

Formulas.  
   (c)  Click the Paste arrow in the Clipboard group and select 

Values & Source Formatting.  
   (d)  Display the Paste Special dialog box and select  Formulas 

and number formats .    

     9.  Assume that the data on a worksheet consume a whole 
printed page and a couple of columns on a second page. You 
can do all of the following except what to force the data to 
print all on one page?  

    (a)  Decrease the Scale value.  
   (b)  Increase the left and right margins.  
   (c)  Decrease column widths if possible.  
   (d)  Select a smaller range as the print area.    

     10.  What should you do if you see a column of pound signs (###) 
instead of values or results of formulas?  

    (a)  Increase the zoom percentage.  
   (b)  Delete the column.  
   (c)  Adjust the row height.  
   (d)  Increase the column width.     
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Practice ExercisesPractice Exercises

  Practice Exercises 

a.   Open  e01p1Math  and save it as  e01p1Math_LastFirst .  
b.   Type the current date in  cell B2  in this format: 9/1/2016. Type your first and last names in  cell D2 .  
c.   Adjust the column widths by doing the following: 

   •   Click in any cell in column A and click  Format  in the Cells group.  
  •   Select  Column Width , type  12.57  in the  Column width box , and then click  OK .  
  •   Click in any cell in column B and set the width to  11 .  
  •   Click in any cell in column D and set the width to  35.57 .    

d.   Select the  range A1:E1 , click  Merge & Center  in the Alignment group, click  Bold , and then apply 
 14 pt font size .  

e.   Select the  range B5:B8  and click  Center  in the Alignment group.  
f.   Select the  range D10:D12  and click  Wrap Text  in the Alignment group.  
  g.   Enter the following formulas in column E: 

   •   Click  cell E5 . Type  =B5+B6  and press  Enter . Excel adds the value stored in cell B5 (1) to the 
value stored in cell B6 (2). The result (3) appears in cell E5, as described in cell D5.  

  •   Enter appropriate formulas in  cells E6:E8 , pressing  Enter  after entering each formula. Subtract 
to calculate a difference, multiply to calculate a product, and divide to calculate a quotient.  

  •   Type  =B6^B7  in  cell E9  and press  Enter . Calculate the answer: 2*2*2 = 8.  
  •   Enter  =B5+B6*B8-B7  in  cell E10  and press  Enter . Calculate the answer: 2*4 = 8; 1+8 = 9; 9−3 = 6. 

Multiplication occurs first, followed by addition, and finally subtraction.  
  •   Enter  =(B5+B6)*(B8-B7)  in  cell E11  and press  Enter . Calculate the answer: 1+2 = 3; 4−3 = 1; 

3*1 = 3. This formula is almost identical to the previous formula; however, calculations in 
parentheses occur before the multiplication.  

  •   Enter  =B5*B6+B7*B8  in  cell E12  and press  Enter . Calculate the answer: 1*2 = 2; 3*4 = 12; 2+12 = 14.    

 You want to brush up on your math skills to test your logic by creating formulas in Excel. You realize 
that you should avoid values in formulas most of the time. Therefore, you created an input area that 
contains values you will use in your formulas. To test your knowledge of formulas, you will create 
an output area that will contain a variety of formulas using cell references from the input area. You 
also need to include a formatted title, the date prepared, and your name. After creating and verifying 
formula results, you will change input values and observe changes in the formula results. You want to 
display cell formulas, so you will create a picture copy of the formulas view. This exercise follows the 
same set of skills as used in Hands-On Exercises 1–4 and 6 in the chapter. Refer to  Figure    52    as you 
complete this exercise.  

  1 Mathematics Review 

FIGURE  52  Formula Practice       
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h.   Edit a formula and the input values: 
   •   Click  cell E12  and click in the Formula Bar to edit the formula. Add parentheses as shown: 

 =(B5*B6)+(B7*B8)  and click  Enter  to the left side of the Formula Bar. The answer is still 14. 
The parentheses do not affect order of precedence because multiplication occurred before the 
addition. The parentheses help improve the readability of the formula.  

  •   Type  2  in  cell B5 ,  4  in  cell B6 ,  6  in  cell B7 , and  8  in  cell B8 .  
  •   Double-check the results of the formulas using a calculator or your head. The new results in 

cells E5:E12 should be 6, 6, 24, 3, 4096, 28, 12, and 56, respectively.    
  i.   Double-click the  Sheet1 tab , type  Results , and then press  Enter . Right-click the  Results tab , select 

 Move or Copy , click  (move to end)  in the  Before sheet  section, click the  Create a copy check box , 
and then click  OK . Double-click the  Results (2) tab , type  Formulas , and then press  Enter .  

  j.   Click the  FORMULAS tab  and click  Show Formulas  in the Formula Auditing group. Double-
click between the column A and column B headings to adjust the column A width. Double-click 
between the column B and column C headings to adjust the column B width. Set  24.0 width  for 
column D.  

  k.   Select the  range A1:E12 , click the  HOME tab , click the  Copy arrow  in the Clipboard group, 
and then select  Copy as Picture . In the Copy Picture dialog box, click  As shown on screen  and 
click  OK .  

  l.   Press  Delete  to delete the selected worksheet data and click  Paste .   

 TROUBLESHOOTING:   If you do not delete the worksheet data, the pasted picture image 
will display over the data, creating a double effect. 

  m.   Make sure the Formulas worksheet is active, click the  PAGE LAYOUT tab , and then do the 
 following: 
   •   Click  Orientation  in the Page Setup group and select  Landscape .  
  •   Click the  View Gridlines check box  in the Sheet Options group to deselect it. The worksheet 

gridlines are hidden, but the gridlines in the picture still display.    
  n.   Click the  FILE tab  and click  Print . Verify that the worksheet will print on one page. Press  Esc  to 

close the Print Preview.  
  o.   Save and close the file, and submit based on your instructor’s directions.    

  2 Calendar Formatting 
 You want to create a calendar for May 2016. The calendar will enable you to practise alignment set-
tings, including centre, merge and centre, and indents. In addition, you will need to adjust column 
widths and increase row height to create cells large enough to enter important information, such as 
birthdays, in your calendar. You will create a formula and use Auto Fill to complete the days of the week 
and the days within each week. To improve the appearance of the calendar, you will add fill colours, 
font colours, borders, and clip art. This exercise follows the same set of skills as used in Hands-On 
Exercises 1–6 in the chapter. Refer to  Figure    53    as you complete this exercise.  

FROM 
SCRATCH
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Practice ExercisesPractice Exercises

a.   Click the  FILE tab , select  New , and then click  Blank workbook . Save the workbook as 
 e01p2May2016_LastFirst .  

b.   Type ’ May 2016  in  cell A1  and click  Enter  on the left side of the Formula Bar.   

 TROUBLESHOOTING:   If you do not type the apostrophe before  May 2016 , the cell will 
display  May-16  instead of  May 2016 . 

  c.   Format the title: 
   •   Select the  range A1:G1  and click  Merge & Center  in the Alignment group.  
  •   Apply  48 pt font size .  
  •   Click the  Fill Color arrow  and click  Green, Accent 6, Lighter 40%  in the  Theme Colors  section 

of the colour palette.    
  d.   Complete the days of the week: 

   •   Type  Sunday  in  cell A2  and click  Enter  on the left side of the Formula Bar.  
  •   Drag the  cell A2 fill handle  across the row through  cell G2  to use Auto Fill to complete the rest 

of the weekdays.  
  •   Click the  Fill Color arrow  and select  Green, Accent 6, Lighter 60% . Click the  Font Color 

arrow  and click  Green, Accent 6, Darker 50% . Apply bold and  14 pt font size . Click  Middle 
Align  and click  Center  in the Alignment group.    

  e.   Complete the days of the month: 
   •   Type  1  in  cell A3  and press  Ctrl+Enter . Drag the  cell A3 fill handle  across the row through  cell 

G3 . Click  Auto Fill Options  in the bottom-right corner of the filled data and select  Fill Series .  
  •   Type  =A3+7  in  cell A4  and press  Ctrl+Enter . Usually you avoid numbers in formulas, but the 

number of days in a week is always 7. Drag the  cell A4 fill handle  down through  cell A7  to get 
the date for each Sunday in May.  

  •   Keep the  range A4:A7  selected and drag the fill handle across through  cell G7 . Select the  range 
D7:G7  and press  Delete  to delete the extra days.    

  f.   Format the columns and rows: 
   •   Select  columns A:G . Click  Format  in the Cells group, select  Column Width , type  16  in the 

 Column width box , and then click  OK .  
  •   Select  row 2 . Click  Format  in the Cells group, select  Row Height , type  54 , and then click  OK .  

FIGURE  53  May 2016 
Calendar       
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  •   Select  rows 3:7 . Set an  80 row height .  
  •   Select the  range A2:G7 . Click the  Borders arrow  in the Font group and select  All Borders .  
  •   Select the  range A3:G7 . Click  Top Align  and  Align Left  in the Alignment group. Click  Increase 

Indent . Bold the numbers and apply  12 pt font size .    
g.   Double-click the  Sheet1 tab , type  May , and then press  Enter .  
h.   Deselect the range and click the  PAGE LAYOUT tab . Click  Orientation  in the Page Setup group 

and select  Landscape .  
i.   Click the  INSERT tab  and click  Header & Footer  in the Text group. Click in the left side of the 

header and type your name. Click in the centre of the header and click  Sheet Name  in the Header 
& Footer Elements group on the DESIGN tab. Click in the right side of the header and click  File 
Name  in the Header & Footer Elements group on the DESIGN tab. Click in any cell in the work-
book and click  Normal  on the status bar.  

  j.   Save and close the file, and submit based on your instructor’s directions.    

  3 Downtown Theatre 
 You are the assistant manager at Downtown Theatre, where touring Broadway plays and musicals are 
performed. You need to complete a spreadsheet to help you analyze ticket sales by seating chart for 
each performance. The spreadsheet will identify the seating sections, total seats in each section, and 
the number of seats sold for a performance. You will then calculate the percentage of seats sold and 
unsold. This exercise follows the same set of skills as used in Hands-On Exercises 1–6 in the chapter. 
Refer to  Figure    54    as you complete this exercise.  

   a.   Open  e01p3TicketSales  and save it as  e01p3TicketSales_LastFirst .  
b.   Double-click the  Sheet1 tab , type  Seating , and then press  Enter .  
c.   Type  3/31/2016  in  cell A3  and press  Enter .  
d.   Adjust alignments and font attributes by doing the following from the Alignment and Font groups 

on the HOME tab: 
   •   Select the  range A1:E1 , click  Merge & Center , click  Bold , click the  Font Size arrow , and then 

select  16 .  
  •   Use the Merge & Center command to merge the  range A2:E2  and centre the subtitle.  
  •   Use the Merge & Center command to merge the  range A3:E3  and centre the date.  
  •   Select the  range A5:E5 , click  Wrap Text , click  Center , and then click  Bold  to format the col-

umn labels.    
e.   Right-click the  row 9 heading  and select  Insert  from the shortcut menu to insert a new row. Type 

the following data in the new row:  Back Floor ,  132 ,  108 .  

  FIGURE  54  Theatre Seating 
Data       
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f.   Move the Balcony row to be the last row by doing the following: 
   •   Click the  row 6 heading  and click  Cut  in the Clipboard group on the HOME tab.  
  •   Right-click the  row 12 heading  and select  Insert Cut Cells  from the menu.    

g.   Adjust column widths by doing the following: 
   •   Double-click between the column A and column B headings.  
  •   Select  columns B  and  C headings  to select the columns, click  Format  in the Cells group, select 

 Column Width , type  9  in the  Column width box , and then click  OK . Because columns B and 
C contain similar data, you set the same width for these columns.  

  •   Set the width of columns D and E to  12 .    
h.   Select the  range B6:C11 , click  Align Right  in the Alignment group on the HOME tab, and then 

click  Increase Indent  twice in the Alignment group.  
i.   Calculate and format the percentage of sold and unsold seats by doing the following: 

   •   Click  cell D6 . Type  =C6/B6  and press  Tab  to enter the formula and make cell E6 the active cell. 
This formula divides the number of seats sold by the total number of Box Seats.  

  •   Type  =(B6-C6)/B6  and click  Enter  on the left side of the Formula Bar to enter the formula and 
keep cell E6 the active cell. This formula must first subtract the number of sold seats from the 
available seats to calculate the number of unsold seats. The difference is divided by the total 
number of available seats to determine the percentage of unsold seats.  

  •   Select the  range D6:E6 , click  Percent Style  in the Number group on the HOME tab, and then 
click  Increase Decimal  in the Number group. Keep the range selected.  

  •   Double-click the  cell E6 fill handle  to copy the selected formulas down their respective col-
umns. Keep the range selected.  

  •   Click  Align Right  in the Alignment group and click  Increase Indent  twice in the Alignment 
group. These actions will help centre the data below the column labels. Do not click Center; 
doing so will centre each value and cause the decimal points not to align. Deselect the range.    

  j.   Display and preserve a screenshot of the formulas by doing the following: 
   •   Click  New sheet , double-click the  Sheet1 tab , type  Formulas , and then press  Enter .  
  •   Click  Select All  in the top-left corner above the row headings and to the left of the column 

headings, click the  Fill Color arrow  in the Font group, and then click  White, Background 1 . 
Applying this fill colour will prevent the cell gridlines from bleeding through the screenshot you 
are about to embed.  

  •   Click the  Seating sheet tab , click the  FORMULAS tab , and then click  Show Formulas  in the 
Formula Auditing group to display cell formulas.  

  •   Click  cell A1  and drag down to  cell E11  to select the range of data. Click the  HOME tab , click 
 Copy arrow  in the Clipboard group, select  Copy as Picture , and then click  OK .  

  •   Click the  Formulas sheet tab , click  cell A1 , and then click  Paste .  
  •   Click the  PAGE LAYOUT tab , click  Orientation  in the Page Setup group, and then select 

 Landscape .  
  •   Click the  Seating sheet tab , click the  FORMULAS tab , and then click  Show Formulas  in the 

Formula Auditing group to hide the cell formulas.    
k.   Click  cell A1 . Click the  PAGE LAYOUT tab , click  Margins  in the Page Setup group, and then 

select  Custom Margins . Click the  Horizontally check box  and click  Print Preview . Excel centres 
the data horizontally based on the widest item. Press  Esc  to leave the Print Preview mode.  

  l.   Click the  Page Setup Dialog Box Launcher , click the  Header/Footer tab  in the Page Setup dialog 
box, click  Custom Footer , type your name in the  Left section box , click in the  Center section box , 
click  Insert File Name , click in the  Right section box , click  Insert Sheet Name , and then click 
 OK . Click  OK .  

  m.   Save and close the file, and submit based on your instructor’s directions.     
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  Mid-Level Exercises 

a.   Open a new Excel workbook, save it as  e01m1Receipt_LastFirst , and then rename  Sheet1  as  Receipt .  
b.   Enter the four labels in the  range A1:A4  in the Input Area as shown in  Figure    56   . Type  9.39 ,  .13 , 

and  .18  in the  range B2:B4 . Apply these formats to the Input Area: 
   •   Merge and centre the  Input Area  title over both columns. Apply bold and  Blue, Accent 1, 

Lighter 40% fill colour  to the title. Adjust the width of the first column.  
  •   Apply the  Accounting Number Format  and  Percent Style  format with the respective decimal 

places as shown in the  range B2:B4 .    
  c.   Enter the labels in the receipt area in column D. Use Format Painter to copy the formats of the title 

in  cells A1  and  D1 . Merge and centre the city and province in the  range D2:E2 . Change the width 
of column D to  17 . Indent the  Subtotal  and  Tip Amount  labels twice each. Apply bold to  Total Bill  
and apply italic to  Thank you for dining with us .  

d.   Enter the following formulas for the receipt: 
   •    Food & Beverages:  Enter a formula that reads the value in the Input Area; do not retype the 

value in cell E4.  
  •    HST Amount:  Calculate the product of the food & beverages and the harmonized sales tax.  
  •    Subtotal:  Determine the formula needed.  
  •    Tip Amount:  Calculate the tip based on the pretax amount and the tip rate.  
  •    Total Bill:  Determine the formula needed.    

e.   Apply  Accounting Number Format  to the  Food & Beverages ,  Subtotal , and  Total Bill  values, if nec-
essary. Apply  Comma Style  and underline to the  HST Amount  and  Tip Amount  values. Apply the 
 Double Underline style  to the  Total Bill  value.  

f.   Set  3.81 cm (1.5")  top margin and centre the data horizontally on the page.  
g.   Insert a footer with your name on the left side, the sheet name code in the centre, and the file name 

code on the right side.  
h.   Create a copy of the Receipt worksheet, move the new sheet to the end, and then rename the copied 

sheet  Formulas . Display cell formulas on the Formulas worksheet, select  Landscape orientation , 
and then select the options to print gridlines and headings. Adjust column widths so that the data 
will fit on one page.  

  i.   Open the Excel Options dialog box while displaying the Formulas worksheet. In the Advanced cat-
egory, under  Display options for this worksheet :, select the  Show formulas in cells instead of their 
calculated results check box . This option will make sure the active worksheet will display the for-
mulas when you open the workbook again. The Receipt worksheet will continue showing the results.  

  j.   Save and close the file, and submit based on your instructor’s directions.    

 Matt, the owner of Matt’s Sports Grill in Timmins, Ontario, asked you to help him create a receipt 
 spreadsheet that he can use until his new system arrives. He wants an input area for the total food and bev-
erage purchases, the harmonized sales tax (HST), and the tip rate. The formatted receipt should include 
the subtotal, tax, tip, and total amount for a customer. Refer to  Figure    55    as you complete this exercise.  

   1  Restaurant Receipt 

FROM 
SCRATCH

DISCOVER

FIGURE  55  Matt’s Sports Grill 
Receipt       
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 You manage a beach guest house in Shediac, New Brunswick, containing three types of rental units. 
Prices are based on peak and off-peak times of the year. You need to calculate the maximum daily rev-
enue for each rental type, assuming all units are rented. In addition, you need to calculate the discount 
rate for off-peak rental times. Finally, you will improve the appearance of the worksheet by applying 
font, alignment, and number formats. 

a.   Open  e01m2Rentals  and save it as  e01m2Rentals_LastFirst .  
b.   Merge and centre  Peak Rentals  in the  range C4:D4 , over the two columns of peak rental data. 

Apply  Dark Red fill colour  and  White, Background 1 font colour .  
  c.   Merge and centre  Off-Peak Rentals  in the  range E4:G4  over the three columns of off-peak rental 

data. Apply  Blue fill colour  and  White, Background 1 font colour .  
  d.   Centre and wrap the headings on row 5. Adjust the width of columns D and F, if needed. Centre 

the data in the  range B6:B8 .  
  e.   Create and copy the following formulas: 

   •   Calculate the Peak Rentals Maximum Revenue by multiplying the number of units by the peak 
rental price per day.  

  •   Calculate the Off-Peak Rentals Maximum Revenue by multiplying the number of units by the 
off-peak rental price per day.  

  •   Calculate the Discount rate for the Off-Peak rental price per day. For example, using the peak 
and off-peak per day values, the studio apartment rents for 75% of its peak rental rate. However, 
you need to calculate and display the off-peak discount rate, which is .24975.    

  f.   Format the monetary values with  Accounting Number Format . Format the Discount Rate for-
mula results in  Percent Style  with one decimal place.  

  g.   Apply  Blue, Accent 1, Lighter 80% fill colour  to the  range E5:G8 .  
  h.   Select the  range C5:D8  and apply a custom colour with  Red 242 ,  Green 220 , and  Blue 219 .  
  i.   Answer the four questions below the worksheet data. If you change any values to answer the ques-

tions, change the values back to the original values.  
  j.   Set  2.54 cm (1")  top, bottom, left, and right margins. Centre the data horizontally on the page.  
  k.   Insert a footer with your name on the left side, the sheet name code in the centre, and the file name 

code on the right side.  
  l.   Create a copy of the Rental Rates worksheet, place the new sheet to the right side of the original 

worksheet, and rename the new sheet  Formulas . On the Formulas worksheet, select  Landscape 
orientation  and the options to print gridlines and headings. Delete the question and answer sec-
tion on the Formulas sheet.  

  m.   Open the Excel Options dialog box while displaying the Formulas worksheet. In the Advanced 
category, under  Display options for this worksheet: , select the  Show formulas in cells instead of 
their calculated results check box . This option will make sure the active worksheet will display 
the formulas when you open the workbook again. The Rental Rates worksheet will continue show-
ing the results. Adjust column widths so that the data will fit on one page.  

  n.   Save and close the file, and submit based on your instructor’s directions.    

   3   Real Estate Sales Report 
 You own a small real estate company in Fort McMurray, Alberta. You want to analyze sales for selected 
properties. Your assistant has prepared a spreadsheet with sales data. You need to calculate the number 
of days that the houses were on the market and their sales percentage of the list price. In one situation, 
the house was involved in a bidding war between two families that really wanted the house. Therefore, 
the sale price exceeded the list price. 

DISCOVER

DISCOVER 

   2   Guest House Rental Rates 

ANALYSIS
CASE
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a.   Open  e01m3Sales  and save it as  e01m3Sales_LastFirst .  
b.   Delete the row that has incomplete sales data. The owners took their house off the market.  
c.   Calculate the number of days each house was on the market. Copy the formula down that column.  
d.   Format prices with  Accounting Number Format  with zero decimal places.  
e.   Calculate the sales price percentage of the list price. The second house was listed for $500,250, but 

it sold for only $400,125. Therefore, the sale percentage of the list price is 79.99%. Format the per-
centages with two decimal places.  

f.   Wrap the headings on row 4.  
g.   Insert a new column between the  Date Sold  and  List Price  columns. Move the  Days on Market  

column to the new location. Apply  Align Right  and increase the indent on the days on market 
formula results. Then delete the empty column B.  

h.   Edit the list date of the 41 Chestnut Circle house to be  4/22/2016 . Edit the list price of the house on 
Amsterdam Drive to be  $355,000 .  

  i.   Select the property rows and set a  20 row height . Adjust column widths as necessary.  
  j.   Select  Landscape orientation  and set the scaling to  130% . Centre the data horizontally and verti-

cally on the page.  
  k.   Insert a header with your name, the current date code, and the current time code.  
  l.   Save and close the file, and submit based on your instructor’s directions.    

       Your instructor wants all students in the class to practise their problem-solving skills. Pair up with a 
classmate so that you can create errors in a workbook and then see how many errors your classmate 
can find in your worksheet and how many errors you can find in your classmate’s worksheet. 

a.   Create a folder named  Exploring  on your SkyDrive and give access to that drive to a classmate and 
your instructor.  

b.   Open  e01h6Markup_LastFirst , which you created in the Hands-On Exercises, and save it as 
 e01m4Markup_LastFirst .  

c.   Edit each main formula to have a deliberate error (such as a value or incorrect cell reference) in it 
and then copy the formulas down the columns.  

d.   Save the workbook to your shared folder on your SkyDrive.  
e.   Open the workbook your classmate saved on his or her SkyDrive and save the workbook with your 

name after theirs, such as  e01m4Markup_MulberyKeith_KrebsCynthia .  
f.   Find the errors in your classmate’s workbook, insert comments to describe the errors, and then cor-

rect the errors.  
g.   Save the workbook back to your classmate’s SkyDrive and submit based on your instructor’s 

 directions.     

COLLABORATION 
CASE

   4  Problem-Solving with Classmates 
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Beyond the ClassroomBeyond the Classroom

  Beyond the Classroom 

DISASTER 
RECOVERY       

RESEARCH 
CASE       

FROM 
SCRATCH

  Credit Card Rebate    You recently found out the Costco TrueEarnings® American Express credit card earns annual 
rebates on all purchases. You want to see how much rebate you would have received had you 
used this credit card for purchases in the past year. Use the Internet to research the percent-
age rebates for different categories. Plan the design of the spreadsheet. Enter the categories, 
rebate percentages, amount of money you spent in each category, and a formula to calculate 
the amount of rebate. Use the Excel Help feature to learn how to add several cells using a 
function instead of adding cells individually and how to apply a Double Accounting under-
line. Insert the appropriate function to total your categorical purchases and rebate amounts. 
Apply appropriate formatting and page setup options for readability. Underline the last mon-
etary values for the last data row and apply the  Double Accounting underline style  to the 
totals. Insert a header. Save the workbook as  e01b2Rebate_LastFirst . Close the workbook 
and submit based on your instructor’s directions.   

  Net Proceeds from 
House Sale   

 Garrett Frazier is a real estate agent. He wants his clients to have a realistic expectation of 
how much money they will receive when they sell their houses. Sellers know they have to 
pay a commission to the agent and pay off their existing mortgages; however, many sellers 
forget to consider they might have to pay some of the buyer’s closing costs, title insurance, 
and prorated property taxes. The realtor commission and estimated closing costs are based 
on the selling price and the respective rates. The estimated property taxes are prorated based 
on the annual property taxes and percentage of the year. For example, if a house sells three 
months into the year, the seller pays 25% of the property taxes. Garrett created a worksheet 
to enter values in an input area to calculate the estimated deductions at closing and calculate 
the estimated net proceeds the seller will receive. However, the worksheet contains errors. 
Open  e01b3Proceeds  and save it as  e01b3Proceeds_LastFirst . 

 Use Help to learn how to insert comments into cells. As you identify the errors, insert 
comments in the respective cells to explain the errors. Correct the errors, including format-
ting errors. Apply  Landscape orientation ,  115% scaling ,  3.81 cm (1.5") top margin , and 
centre horizontally. Insert your name on the left side of the header, the sheet name code in 
the centre, and the file name code on the right side. Save and close the workbook, and submit 
based on your instructor’s directions.   

SSOFT SKILLS 
CASE       

FROM 
SCRATCH

  Goal Setting    After watching the Goal Setting video, start a new Excel workbook and save it as  e01b4Goals_
LastFirst . List three descriptive goals in column A relating to your schoolwork and degree 
completion. For example, maybe you usually study three hours a week for your algebra class, 
and you want to increase your study time by 20%. Enter  Algebra homework & study time 
(hours)  in column A,  3  in column B, the percentage change in column C, and create a for-
mula that calculates the total goal in column D. Adjust column widths as needed. 

 Insert column labels above each column. Format the labels and values using information 
you learned earlier in the chapter. Merge and centre a title at the top of the worksheet. Use 
the Page Setup dialog box to centre the worksheet horizontally. Rename Sheet1 using the 
term, such as  Fall 2016 . Create a footer with your name on the left side, sheet name code in 
the centre, and file name code on the right side. Save and close the workbook, and submit 
based on your instructor’s directions.    
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  You manage a publishing company that publishes and sells books 
to bookstores in Austin. Your assistant prepared a standard 
 six-month  royalty statement for one author. You need to insert 
 formulas,  format the worksheets, and then prepare royalty state-
ments for other authors.  

  Enter Data into the Worksheet 
 You need to format a title, enter the date indicating the end of the 
statement period, and delete a blank column. You also need to 
insert a row for the standard discount rate, a percentage that you 
discount the books from the retail price to sell to the bookstores. 

a.  Open  e01c1Royalty  and save it as  e01c1Royalty_LastFirst .  

  b.   Merge and centre the title over the  range A1:D1 .  

  c.   Type  6/30/2016  in  cell B3  and left-align the date.  

  d.   Delete the blank column between the  Hardback  and 
 Paperback  columns.  

  e.   Insert a new row between  Retail Price  and  Price to 
Bookstore . Enter  Standard Discount Rate ,  0.55 , and  0.5 . 
Format the two values as  Percent Style .    

  Calculate Values 
 You need to insert formulas to perform necessary calculations. 

a.  Enter the Percent Returned formula in  cell B10 . The per-
cent returned indicates the percentage of books sold but 
returned to the publisher.  

  b.   Enter the Price to Bookstore formula in  cell B15 . This is 
the price at which you sell the books to the bookstore. It 
is based on the retail price and the standard discount. For 
example, if a book has a $10 retail price and a 55% dis-
count, you sell the book for $4.50.  

  c.   Enter the Net Retail Sales formula in  cell B16 . The net 
retail sales is the revenue from the net units sold at the 
retail price. Gross units sold minus the returned units 
equals net units sold.  

  d.   Enter the Royalty to Author formula in  cell B20 . Royalties 
are based on net retail sales and the applicable royalty rate.  

  e.   Enter the Royalty per Book formula in  cell B21 . This amount 
is the author’s earnings on every book sold but not returned.  

  f.   Copy the formulas to the Paperback column.    

  Format the Values 
 You are ready to format the values to improve readability. 

a.  Apply  Comma Style  with zero decimal places to the 
range B8:C9 .  

b.  Apply  Percent Style  with one decimal place to the  range 
B10:C10  and  Percent Style  with two decimal places to 
the  range B19:C19 .  

  c.   Apply  Accounting Number Format  to all monetary values.    

  Capstone Exercise 
  Format the Worksheet 
 You want to improve the appearance of the rest of the worksheet. 

   a.   Select the  range B6:C6 . Apply bold, right alignment, and 
 Purple font colour .  

  b.   Click  cell A7 , apply  Purple font colour , and then apply 
 Gray-25%, Background 2, Darker 10% fill colour . 
Select the  range A7:C7  and select  Merge Across .  

  c.   Use Format Painter to apply the formats from  cell A7  to 
 cells A12  and  A18 .  

  d.   Select the  ranges A8:A10 ,  A13:A16 , and  A19:A21 . 
Indent the labels twice. Widen column A as needed.  

  e.   Select the  range A7:C10  (the  Units Sold  section) and apply 
the  Outside Borders  border style. Apply the same border 
style to the  Pricing  and  Royalty Information  sections.    

  Manage the Workbook 
 You will apply page setup options insert a footer, and, then duplicate 
the royalty statement worksheet to use as a model to prepare a roy-
alty statement for another author. 

   a.   Select the margin setting to centre the data horizontally 
on the page. Insert a footer with your name on the left 
side, the sheet name code in the centre, and the file name 
code on the right side.  

  b.   Copy the Jacobs worksheet, move the new worksheet to 
the end, and then rename it  Lopez .  

  c.   Change the Jacobs sheet tab to  Red . Change the Lopez 
sheet tab to  Dark Blue .  

  d.   Make these changes on the Lopez worksheet:  Lopez  
(author),  5000  (hardback gross units),  14000  (paperback 
gross units),  400  (hardback returns),  1925  (paperback 
returns),  19.95  (hardback retail price), and  6 . 95  
(paperback retail price).    

  Display Formulas and Print the Workbook 
 You want to print the formatted Jacobs worksheet to display the cal-
culated results. To provide evidence of the formulas, you want to dis-
play and print cell formulas in the Lopez worksheet. 

   a.   Display the cell formulas for the Lopez worksheet.  

  b.   Select options to print the gridlines and headings.  

  c.   Change the Options setting to make sure the formulas 
display instead of cell results on this worksheet when you 
open it again.  

  d.   Adjust the column widths so that the formula printout 
will print on one page.  

  e.   Save and close the workbook, and submit based on your 
instructor’s directions.                  
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